Process Automation Guide for Automation for SAP BW and BWA

Release 3.0
December 2013
CONTENTS

New and Changed Information vii
  Latest Release vii
  Previous Release vii ix

Preface xi
  Organization xi
  Conventions xii

Product Documentation xiii
  Documentation Formats xiii
  Guides and Release Notes xiii
  Online Help xiii
  Open Source License Acknowledgements xiii

Obtaining Documentation and Submitting a Service Request xiv

CHAPTER 1

Importing Automation Packs 1-1
  Accessing the Automation Pack Import Wizard 1-2
    Opening the Import Wizard After Running Setup Wizard 1-2
    Opening the Import Wizard in Console 1-3
  Importing the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap 1-4
  Importing the Common Activities.tap 1-5
  Importing the Automation for SAP BW and BWA.tap 1-6
  Importing ABAP Transport or Cisco Add-On 1-6
    Importing the ABAP Transport Files On SAP Systems 1-7
    Importing the Cisco Add-On On SAP Systems 1-8
    Error Handling, Logging and Tracing for ABAP Add-on 1-8
    Support desk management for ABAP Add-on 1-9
  Installing TREX Script Files 1-9

CHAPTER 2

Understanding Automation Pack Objects 2-1
  Accessing Automation Pack Properties 2-1
  Viewing Automation Pack Content and Dependencies 2-3
    Viewing Automation Pack Content 2-3
    Automation for SAP BW and BWA Processes 2-3
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation for SAP BW and BWA Target Properties</td>
<td>2-6</td>
</tr>
<tr>
<td>Automation for SAP BW and BWA Global Variables</td>
<td>2-7</td>
</tr>
<tr>
<td>Automation for SAP BW and BWA Knowledge Base Articles</td>
<td>2-8</td>
</tr>
<tr>
<td>Viewing Automation Pack Dependencies</td>
<td>2-9</td>
</tr>
</tbody>
</table>

## Chapter 3

### Getting Started Using the Automation Pack 3-1

- Creating an SAP User 3-2
- Creating Targets 3-3
  - Creating SAP System Targets 3-3
  - Creating BWA Unix/Linux Target 3-6
    - Creating Reference to BWA Unix/Linux Target 3-10
- Using Task Rules for Assignments and Notifications 3-10
  - Accessing Task Rules View 3-10
  - Configuring Task Rules 3-12
    - SAP Default Assignment 3-12
  - Creating a New Task Rule 3-12
  - Managing Task Rule Definitions 3-20
    - Enabling a Task Rule 3-20
    - Disabling a Task Rule 3-20
    - Creating a Copy of a Task Rule 3-22
    - Sorting Task Rules 3-22
    - Deleting a Task Rule 3-22
  - Enabling Notification Based on Assignment Processes 3-23
- Managing Target Properties 3-24
  - Accessing Target Properties 3-24
  - Configuring Target Properties 3-25

## Chapter 4

### Managing Automation for SAP BW and BWA Processes 4-1

- Accessing Automation for SAP BW and BWA Processes 4-2
  - Filtering Processes by Category 4-2
  - Managing SAP Processes 4-2
    - Enabling a Process 4-2
    - Disabling a Process 4-4
    - Modifying Process Instance Archival 4-4
    - Modifying a Process Schedule 4-5
  - Running Processes 4-6
    - Starting a Process 4-6
    - Viewing Running Process 4-7
  - Viewing Process Results 4-8
Contents

Accessing Process View  4-8
Viewing Activity Results  4-8
Viewing Incidents  4-8
Viewing Automation Summary  4-9

APPENDIX A

Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content  A-1

Automation Pack Content  A-1
  Core Automation for SAP BW, BOBJ and In-Memory Computing Processes  A-1
  Core Automation for SAP BW, BOBJ and In-Memory Computing Activities  A-2
  Core Automation for SAP BW, BOBJ and In-Memory Computing Target Properties  A-2
  Core Automation for SAP BW, BOBJ and In-Memory Computing Global Variables  A-3
  Core Automation for SAP BW, BOBJ and In-Memory Computing Target Groups  A-3

Automation Pack Dependencies  A-4

Core Automation for SAP BW, BOBJ and In-Memory Computing Activities  A-4
  Defining an Activity  A-6
  Viewing Activity Results  A-9

Defining the BWA TREX Activities  A-10
  BWA TREX—Cancel Running Reorganization Activity  A-10
  BWA TREX—Continue Reorganization Activity  A-11
  BWA TREX—Delete All Indexes Activity  A-12
  BWA TREX—Delete Index Activity  A-13
  BWA TREX—Execute Query Activity  A-13
  BWA TREX—Get Alert Details Activity  A-15
  BWA TREX—Get Alerts Activity  A-15
  BWA TREX—Get Index Usage Activity  A-17
  BWA TREX—Get Indexes Activity  A-17
  BWA TREX—Get Landscape Summary Activity  A-19
  BWA TREX—Get Last Reorganization Plan Activity  A-19
  BWA TREX—Get Load Metrics Activity  A-21
  BWA TREX—Get Loaded Indexes Activity  A-21
  BWA TREX—Get Long Running Threads Activity  A-23
  BWA TREX—Get Next Reorganization Plan Activity  A-23
  BWA TREX—Get Reorganization Summary Activity  A-25
  BWA TREX—Get Service Statistics Activity  A-26
  BWA TREX—Preload Index Activity  A-27
  BWA TREX—Restart Service Activity  A-27
  BWA TREX—Start Reorganization Activity  A-29
  BWA TREX—Test HTTP Status Activity  A-29
  BWA TREX—Unload Index Activity  A-31
APPENDIX B

Understanding the Common Activities Content B-1
Automation Pack Content B-1
Defining the Common Activities B-2
  Defining the Convert Integer to IP Address Activity B-2
  Defining the Convert IP Address to Integer Activity B-3
  Defining the Ping Activity B-4
  Defining the Stop a Unix Process Activity B-5
  Defining the Stop a Windows Process Activity B-6
New and Changed Information

New and changed information for the most recent releases of the Process Automation Guide for Automation for SAP BW and BWA is as follows:

- **Latest Release**
- **Previous Release**

## Latest Release

**Table 1  December 2013—Process Automation Guide for Automation for SAP BW and BWA 3.0 Changes**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revised Text Part Number (-01 to -02).</td>
<td>Front cover, footers</td>
</tr>
<tr>
<td>Updated Trademark and Copyright date</td>
<td>Inside cover page</td>
</tr>
<tr>
<td>Renamed the Product Name</td>
<td>All Chapters</td>
</tr>
</tbody>
</table>

## Previous Release

**Table 2  April 2012—Process Automation Guide for Automation for SAP BW and BWA 2.3 Changes**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revised Text Part Number (-01 to -02).</td>
<td>Front cover, footers</td>
</tr>
<tr>
<td>Updated Trademark and Copyright date</td>
<td>Inside cover page</td>
</tr>
<tr>
<td>Updated “Importing ABAP Transport or Cisco Add-On” section</td>
<td>Chapter 1, “Importing Automation Packs”</td>
</tr>
<tr>
<td>New feature for supporting duplicate SAP system IDs</td>
<td>Chapter 3, “Getting Started Using the Automation Pack”</td>
</tr>
</tbody>
</table>
### Table 2: April 2012—Process Automation Guide for Automation for SAP BW and BWA 2.3 Changes

<table>
<thead>
<tr>
<th>Feature</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated “Defining an Activity” section</td>
<td>Appendix A, “Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content”</td>
</tr>
<tr>
<td>Renamed appendix based on automation pack name</td>
<td>Appendix A, “Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content”</td>
</tr>
<tr>
<td>Added appendix for Common Activities automation pack (dependency)</td>
<td>Appendix B, “Common Activities Automation Pack Content”</td>
</tr>
</tbody>
</table>
Preface

The SAP automation pack files are a collection of Cisco Process Orchestrator (CPO) processes (workflows) authored by subject matter experts that work out-of-the-box to automate best practices for a particular technology. The automation pack files also include configuration objects that are used in the processes, such as variables, categories, target groups and knowledge base articles.

The SAP Automation Pack for Automation for SAP BW and BWA includes the content used to automate best practices for monitoring SAP BW availability, operations and performance. Cisco Process Orchestrator provides event correlation and root cause analysis capabilities, and intelligently manages the flood of incoming incidents by analyzing them in the context of the other incidents, events and metrics. When critical problems are detected, you are notified with a thorough description of the problem and recommendations for resolving it using language appropriate for both administrators and operators.

This guide is intended to provide information on importing and using the Automation for SAP BW and BWA automation pack in Process Orchestrator.

Organization

This guide includes the following sections:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1</td>
<td>Importing Automation Packs</td>
<td>Provides instructions for installing the automation pack during or after the initial installation of Process Orchestrator.</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Understanding Automation Pack Objects</td>
<td>Provides information on the objects included in the automation pack.</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Getting Started Using the Automation Pack</td>
<td>Provides information on configuring the objects in Process Orchestrator that are referenced by the content in the automation pack—runtime users, targets, task rules, and target properties.</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Managing Automation for SAP BW and BWA Processes</td>
<td>Provides information on using and managing the SAP BW and BWA processes.</td>
</tr>
</tbody>
</table>
Appendix A  Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content
Provides information on the content included in the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

Appendix B  Understanding the Common Activities Content
Provides information on the content included in the Common Activities automation pack.

Conventions

This guide uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong> font</td>
<td>Commands and keywords and user-entered text appear in <strong>bold</strong> font.</td>
</tr>
<tr>
<td><em>italic</em> font</td>
<td>Document titles, new or emphasized terms, and arguments for which you supply values are in <em>italic</em> font.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Elements in square brackets are optional.</td>
</tr>
<tr>
<td>{x</td>
<td>y</td>
</tr>
<tr>
<td>[ x</td>
<td>y</td>
</tr>
<tr>
<td><strong>string</strong></td>
<td>A nonquoted set of characters. Do not use quotation marks around the string or the string will include the quotation marks.</td>
</tr>
<tr>
<td><strong>courier</strong> font</td>
<td>Terminal sessions and information the system displays appear in <strong>courier</strong> font.</td>
</tr>
<tr>
<td>&lt; &gt;</td>
<td>Nonprinting characters such as passwords are in angle brackets.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Default responses to system prompts are in square brackets.</td>
</tr>
<tr>
<td>!, #</td>
<td>An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.</td>
</tr>
</tbody>
</table>

**Note**
Means reader take note.

**Tip**
Means the following information will help you solve a problem.

**Caution**
Means reader be careful. In this situation, you might perform an action that could result in equipment damage or loss of data.

**Timesaver**
Means the described action saves time. You can save time by performing the action described in the paragraph.
Warning

Means reader be warned. In this situation, you might perform an action that could result in bodily injury.

Product Documentation

Documentation Formats

Documentation is provided in the Adobe® Acrobat® PDF files format. You must have Adobe® Reader® installed to read the PDF files. Adobe Reader installation programs for common operating systems are available for free download from the Adobe Web site at www.adobe.com.

Guides and Release Notes

You can download the product documentation from the Enterprise Orchestrator CD location. Release Notes can be found on Cisco.com and the product CD.

Online Help

Online help is available and can be accessed using the following methods:

- Click the Help button on any dialog in the application to open the help topic in a pane to the right of the dialog.
- In the Cisco Process Orchestrator console:
  - Click the Help Pane tool on the toolbar to open the help topic in a pane to the right of the console results pane.
  - Click Help on the menu bar.

Open Source License Acknowledgements

Licenses and notices for open source software used in Cisco Process Orchestrator can be found in the Open Source License Acknowledgements found on Cisco.com. If you have any questions about the open source contained in this product, please email external-opensource-requests@cisco.com.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, subscribe to the What’s New in Cisco Product Documentation as a RSS feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS Version 2.0.
Importing Automation Packs

The *Cisco Process Orchestrator Installation Guide* provides instructions for installing Cisco Process Orchestrator and the core components. During the initial installation of Cisco Process Orchestrator, you can choose to import the automation packs, or import them later from within the Console.

The SAP Automation Pack for Automation for SAP BW and BWA has a dependency on other automation packs so these must be imported prior to importing the Automation for SAP BW and BWA automation pack.

This chapter guides you through importing the automation packs, which contain the content for automating processes to manage and monitor your SAP environment. It contains the following sections:

- Accessing the Automation Pack Import Wizard, page 1-2
- Importing the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap, page 1-4
- Importing the Common Activities.tap, page 1-5
- Importing the Automation for SAP BW and BWA.tap, page 1-6
- Importing ABAP Transport or Cisco Add-On, page 1-6
- Installing TREX Script Files, page 1-9

**Note**

It is recommended that you review the system requirements and prerequisites before importing automation packs. *See the Intelligent Automation for SAP 3.0 Installation Guide.*
Accessing the Automation Pack Import Wizard

You use the Automation Pack Import Wizard to import the automation packs (tap files). You can either open the wizard immediately after installing Cisco Process Orchestrator or from within the Console.

Opening the Import Wizard After Running Setup Wizard

Step 1
After running the Setup wizard to install the product, ensure that the **Launch automation pack import wizard now** check box is checked before closing the wizard.

The Select Automation Packs dialog box displays the available automation packs. All automation packs are checked by default.

Step 2
Ensure that the following check boxes are checked and then click **OK** to launch the Automation Pack Import Wizard:

- Assessment for SAP BWA (*dependency*)
- Automation for SAP BW and BWA
- Common Activities (*dependency*)
- Core Automation for SAP (*dependency*)
- Core Automation for SAP BW, BOBJ and In-Memory Computing (*dependency*)

**Note**
See the *Cisco Process Orchestrator Cisco Process Automation Guide for Assessment for SAP BWA* for instructions on importing the Core Automation for SAP and Assessment for SAP BWA automation packs.

**Note**
See the *Cisco Process Orchestrator Installation Guide* for instructions on importing and configuring the Core components for the product.

Proceed to Importing the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap, page 1-4.
Opening the Import Wizard in Console

You can open the Automation Pack Import Wizard from within the Console after installing the product. When importing automation packs from within the Console, you must re-open the Automation Pack Import Wizard for each automation pack that you are importing.

Because the Automation for SAP BW and BWA automation pack has dependencies on the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack, you must first import this automation pack.

Note

The following instructions assume you have already imported the Core Automation for SAP and the Assessment for SAP BWA automation packs.

Step 1
In the Administration workspace on the Console, click Automation Packs in the navigation pane.

Step 2
Use one of the following methods to open the Automation Pack Import Wizard:

- In the navigation pane, right-click Automation Packs and choose Import.
- On the Menu bar, choose Actions > Import.

Step 3
On the Windows Open dialog box, select the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap file and click Open to open the Automation Pack Import Wizard.

Proceed to Importing the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap, page 1-4.
Importing the Core Automation for SAP BW, BOBJ and In-Memory Computing.tap

You must first import the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack (Core Automation for SAP BW, BOBJ and In-Memory Computing.tap). If you opened the Automation Pack Import Wizard from the Setup Completed panel, the wizard will guide you through importing each automation pack.

**Step 1**
On the Automation Pack Import Wizard Welcome panel, click Next.

**Note**
If you do not want to display the Welcome panel the next time the wizard is opened, check the Do not show this page next time check box.

**Step 2**
On the General Information panel, review the information about the automation pack.

**Step 3**
If you want to disable all the processes that are imported with the automation pack, check the Disable all imported processes check box.

**Note**
If you disable the imported processes, you will need to manually enable the processes in the Console before they can execute.

**Step 4**
Click Next to continue.

The Data Extraction panel is used to specify the destination where the BWA Script files will be extracted. The script files are used in the direct TREX monitoring processes and must be copied to the TREX server.

**Note**
If you uncheck the BWA Scripts check box, the files will not be extracted.

**Step 5**
Accept the default location or click the Browse tool to specify a different location to extract the files and then click Next.

The Review Prerequisites panel displays the prerequisites for the automation pack being imported. The green check mark indicates that the prerequisite was found on the computer.

The red X indicates that the prerequisite was not found on the computer. When this occurs, the import process is stopped and cannot continue until all prerequisites have been met.

If all prerequisites are passed, the wizard automatically continues to the next panel.

**Note**
If you opened the Automation Pack Import Wizard from the Setup Completed panel, the wizard displays the General Information panel for the next automation pack.

**Step 6**
After the objects have been imported, review the information on the Completing the Automation Pack Import Wizard panel to verify that it is correct and then click Close to exit the wizard.
Chapter 1      Importing Automation Packs

Importing the Common Activities.tap

If you are importing the automation packs from within the Console, you must re-open the Automation Pack Import Wizard to import the Common Activities automation pack.

Step 1  Use one of the following methods to open the Import Automation Pack Wizard:

- In the navigation pane, right-click Automation Packs and choose Import.
- On the Menu bar, choose Actions > Import.

Step 2  On the Windows Open dialog box, select the Common Activities.tap file and click Open to launch the Automation Pack Import Wizard.

Step 3  On the Welcome panel, click Next.

Step 4  On the General Information panel, review the information about the automation pack.

Step 5  If you want to disable all the processes that are imported with the automation pack, check the Disable all imported processes check box.

Note  If you disable the imported processes, you will need to manually enable the processes in the Console before they can execute.

Step 6  Click Next to continue.

If all prerequisites are passed, the wizard automatically continues to the next panel.

Step 7  After the objects have been imported, review the information on the Completing the Automation Pack Import Wizard panel to verify that it is correct and then click Close to exit the wizard.
Importing the Automation for SAP BW and BWA.tap

If you are importing the automation packs from within the Console, you must re-open the Automation Pack Import Wizard to import the Automation for SAP BW and BWA automation pack.

---

**Step 1**

Use one of the following methods to open the Import Automation Pack Wizard:

- In the navigation pane, right-click Automation Packs and choose Import.
- On the Menu bar, choose Actions > Import.

**Step 2**

On the Windows Open dialog box, select the Automation for SAP BW and BWA.tap file and click Open to launch the Automation Pack Import Wizard.

**Step 3**

On the Welcome panel, click Next.

**Step 4**

On the General Information panel, review the information about the automation pack.

**Step 5**

If you want to disable all the processes that are imported with the automation pack, check the Disable all imported processes check box.

**Note**

If you disable the imported processes, you will need to manually enable the processes in the Console before they can execute.

**Step 6**

Click Next to continue.

The Data Extraction panel is used to specify the destination where the ABAP Transport files will be extracted. The ABAP Transport files must be installed on the SAP systems on which some remote function calls that are used in this automation pack will be executed.

**Note**

If you uncheck the ABAP Transport check box, the files will not be extracted.

**Step 7**

Accept the default location or click the Browse tool to specify a different location to extract the files and then click Next.

If all prerequisites are passed, the wizard automatically continues to the next panel.

**Step 8**

After the objects have been imported, review the information on the Completing the Automation Pack Import Wizard panel to verify that it is correct and then click Close to exit the wizard.

---

**Importing ABAP Transport or Cisco Add-On**

The Automation for SAP BW and BWA automation pack contains processes that execute RFC calls on the SAP system targets. These RFCs require either the ABAP Transport files or the Cisco Add-On file to be installed on the SAP systems on which the RFCs will be used.

After you have imported the Automation for SAP BW and BWA automation pack, you must import one of the following on the SAP systems where the RFCs will be used:

- ABAP Transport Files (SAP 3.5, 7.0 and 7.1 systems)
- Cisco Add-On File (SAP 7.0 and 7.1 systems)
Importing the ABAP Transport Files On SAP Systems

You can use the ABAP Transport files that ship with the automation pack on SAP 3.5 and 7.0 systems. Perform the following procedure to import the ABAP Transport files on all the SAP System targets where the RFCs will be used.

**Step 1** Navigate to the location where the ABAP Transport data was extracted for the SAP version of the systems in your environment. The default location is:

C:\user\[username]\Documents\Cisco\Cisco Process Orchestrator\Extracted Data\ABAP Transports\SAP BW\Transports\3.5

3.5

7.0

7.1

**Step 2** Copy the files to the following locations on the SAP server:

- K files should be copied to usr\sap\trans\cofiles
- R files should be copied to usr\sap\trans\data

**Step 3** Log onto the SAP system and run T-code STMS.

**Step 4** Follow SAP procedures for performing the transport.
Importing the Cisco Add-On On SAP Systems

Perform the following procedure to import the Cisco add-on file on all SAP System targets where the RFCs will be used.

---

**Step 1** Navigate to the location where the ABAP Transport data was extracted for the SAP version of the systems in your environment. The default location is:

C:\user\[username]\Documents\Cisco\Cisco Process Orchestrator\Extracted Data\ABAP Transports\SAP BW\Add-on\  
  7.0  
  7.1

**Step 2** Copy the SAP Add-On Package file(s) to the following location on the SAP server:

usr\sap\trans\EPS\in

**Step 3** Log onto client 000 of the SAP system using an administrator account (DDIC or SAP* are not valid accounts) and run the SAP transaction code SAINT.

**Step 4** Follow the standard SAP procedures for performing an add-on product installation using SAINT.

---

**Note** To verify whether the add-on is on the SAP system, use the SAP menu path **System > Status** and review the software component versions for the Cisco software component add-on.

---

Error Handling, Logging and Tracing for ABAP Add-on

The ABAP Add-On contains API enabled ABAP function modules (RFC’s) that are called by the Cisco Process Orchestrator application. This is performed in Process Orchestrator by defining an ABAP adapter step and specifying a method for the SAP Target system in a process. Process Orchestrator ABAP custom methods perform individual tasks such as updating RFC Destinations, configuring printers, and so on.

In the event the method encounters an error, such as attempting to modify an RFC destination that does not exist, an error result is returned to the Process Orchestrator process. This can then be modeled as an outcome to the activity, and then subsequent actions based on the error returned may be performed.

All RFC activity performed by Cisco Process Orchestrator may be traced through SAP Standard RFC tracing functionality. Refer to SAP online help for enabling the trace level for RFC communication on the SAP target system using SAP transaction SM59. The SAP methods that are called may either write log entries to the SAP System Log (SAP Transaction SM21) or to the Application log (SAP Transaction SLG1) depending on the SAP standard application functionality. For instance, the SAP Application log is updated during the BDLS process scenario as this part of the SAP standard application functionality.
Support desk management for ABAP Add-on

SAP Root Cause Analysis ABAP tools can be used to review the performance and execution of the RFC calls performed by the Process Orchestrator system. A read-only SAP Administrator user is used to review the functionality performed by the ABAP methods. The following roles are to be the basis for a composite role that can be adapted to the customer environment:

- SAP_BC_BASIS_MONITORING,
- SAP_BC_SEC_USER_DISPLAY,
- SAP_BC_BTC_DISPLAY,
- SAP_BC_MID_ALE_DISPLAY

Installing TREX Script Files

After you have completed importing the automation packs, you must install the script files to the TREX server. These script files are used in the direct TREX monitoring and corrective actions processes.

Note

SAP BWA TREX Scripting is supported only on SAP BWA v7.20, Release 8 or later.

The script files are imported to the following location on the Process Orchestrator server by default:

**Microsoft Windows Server 2003:**
C:\Documents and Settings\local_user\My Documents\Cisco\Cisco Process Orchestrator\Extracted Data\BWA Scripts

**Microsoft Windows Server 2008:**
C:\Users\local_user\Documents\Cisco\Cisco Process Orchestrator\Extracted Data\BWA Scripts

Copy the BWA Scripts folder to the BWA host filesystem and run the `install.sh` command from the Bash shell to install the script files.

Note

Both the `install.sh` and `cisco_teo_python.tar` files need to be copied to the server prior to running the `install.sh` command.

The script files are copied to the `$DIR_INSTANCE\exe\python_support` directory.
Understanding Automation Pack Objects

The Automation for SAP BW and BWA automation pack includes the content used to automate best practices for monitoring SAP BW availability, operations and performance. This chapter provides information on the content included in the Automation for SAP BW and BWA automation pack. It contains the following sections:

- Accessing Automation Pack Properties, page 2-1
- Viewing Automation Pack Content and Dependencies, page 2-3

Accessing Automation Pack Properties

You can access the automation pack properties from the Administration—Automation Packs view in the console. The automation pack properties dialog box displays general information about the content provided by the automation pack, version number, publish date, the provided objects, the dependencies of the automation pack, and the history of changes made to the automation pack.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Name</td>
<td>Name of the company that released the automation pack.</td>
</tr>
<tr>
<td>Publish Date</td>
<td>Date the automation pack was created or exported to a file.</td>
</tr>
<tr>
<td>Version</td>
<td>Version number of the automation pack.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Name of the automation pack.</td>
</tr>
<tr>
<td>ID</td>
<td>Identification number of the automation pack.</td>
</tr>
<tr>
<td>Import Date</td>
<td>Date the automation pack was imported into the product.</td>
</tr>
<tr>
<td>Licensed</td>
<td>Indicates whether the automation is a licensed product in Process Orchestrator.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the automation pack.</td>
</tr>
</tbody>
</table>

Step 1  On the Administration workspace, click Automation Packs in the navigation pane to display the installed automation packs in the Automation Packs pane.

Information about the automation packs display in the following columns:

Step 2  Select the automation pack in the Automation Packs pane, right-click and choose Properties.
Step 3  On the Properties dialog box, click the appropriate tab to view the automation pack properties:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Displays general information about the automation pack.</td>
</tr>
<tr>
<td>Objects</td>
<td>Display a list of objects contained in the automation pack.</td>
</tr>
<tr>
<td>Dependencies</td>
<td>Display a list of automation packs and adapters referenced by the objects in the automation pack.</td>
</tr>
<tr>
<td>History</td>
<td>Displays when the automation pack was created or modified, and audit log entries that are relevant to the automation pack.</td>
</tr>
</tbody>
</table>

Step 4  Click Close to close the dialog box.
Viewing Automation Pack Content and Dependencies

Use the automation pack Properties dialog box to view the objects contained in the automation packs and the dependencies associated with the automation pack.

*Note*

See Appendix A, “Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content” for information on the content included in the dependent automation pack.

See Appendix B, “Understanding the Common Activities Content” for information on the content included in the dependent automation pack.

Viewing Automation Pack Content

**Step 1**
On the Administration—Automation Packs view, select Automation for SAP BW and BWA, right-click and choose Properties.

**Step 2**
On the Automation for SAP BW and BWA Properties dialog box, click the Objects tab.

**Step 3**
On the Objects tab, review the information about the objects provided by the Automation for SAP BW and BWA automation pack.

<table>
<thead>
<tr>
<th>Columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name of the object (processes, global variables, knowledge base).</td>
</tr>
<tr>
<td>Type</td>
<td>Object type.</td>
</tr>
<tr>
<td>Action Required</td>
<td>Action required to successfully import or export the objects.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the object.</td>
</tr>
<tr>
<td>Version</td>
<td>Object version.</td>
</tr>
</tbody>
</table>

Automation for SAP BW and BWA Processes

The following table contains the processes that are imported by the Automation for SAP BW and BWA automation pack.

*Note*

The BWA Status Check and BWA Checklist processes execute the custom method BW–TREX Get Landscape Status Summary that shows the status based on SAP thresholds. Alert server thresholds can be changed using the standalone TREX Admin Tool run directly from Linux shell.

For instructions on using the TREX Admin Tool, refer to the SAP article.
<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adhoc – BWA Create and Fill Indexes – List Input</td>
<td>Used to create and fill BWA indexes. The input variable is a list of InfoCubes (one per line).</td>
</tr>
<tr>
<td>Adhoc – BWA Create and Fill Indexes – Wildcard Input</td>
<td>Used to create and fill BWA indexes. The input variable can be a wildcard.</td>
</tr>
<tr>
<td>Adhoc – BWA Index Reorganization</td>
<td>Executes reorganization plan to distribute the indexes in a TREX system landscape to achieve a balanced memory and CPU load.</td>
</tr>
<tr>
<td>BW Accelerator Status – CCMS</td>
<td>Monitors BW Accelerator status based on CCMS.</td>
</tr>
<tr>
<td>BW Checklist</td>
<td>Automates the most important and frequent administration tasks for monitoring BW system health. This process detects and analyzes common error conditions that typically need to be addressed by system administrators.</td>
</tr>
<tr>
<td>BW FTP Source Availability</td>
<td>Proactively checks connectivity of selected FTP Destinations.</td>
</tr>
<tr>
<td>BW Infocube Dimension Ratio</td>
<td>Proactively monitors BW infocube dimension table size for performance impact and alerts when the dimension to fact table size ratio is too large.</td>
</tr>
<tr>
<td>BW OLAP Connectivity</td>
<td>Proactively monitors OLAP interface connectivity.</td>
</tr>
<tr>
<td>BW Query Response Time</td>
<td>Monitors the query execution response time. This process does not use BWA index for the query execution.</td>
</tr>
<tr>
<td>BW Report Performance Monitoring</td>
<td>Samples report query response time for a custom defined set of reports.</td>
</tr>
<tr>
<td>BW SAP Source System Extraction Error</td>
<td>Detects and analyzes the cause of aborted BW source system extraction jobs. This process examines the job log to accurately identify the cause of the aborted extraction job.</td>
</tr>
<tr>
<td>BW tRFC Source System Availability</td>
<td>Proactively checks connectivity of selected BW Source System RFC Destinations. This process issues an RFC connection test and identifies which RFC destinations have lost connectivity.</td>
</tr>
<tr>
<td>BWA Alert Monitoring</td>
<td>Proactively monitors BWA status.</td>
</tr>
<tr>
<td>BWA Alerts – Automate Actions</td>
<td>Automates the execution of recommended BWA actions.</td>
</tr>
<tr>
<td>BWA Checklist</td>
<td>Automates administration tasks for monitoring BWA system health.</td>
</tr>
<tr>
<td>BWA Create and Fill Indexes (InfoCubes List from Excel)</td>
<td>The Assessment for SAP BWA process creates an Excel spreadsheet in each execution and the results can be used by this process.</td>
</tr>
<tr>
<td>BWA Create and Fill Indexes (InfoCubes List from Global Variable)</td>
<td>Used to create and fill BWA indexes from a list of infocubes in a global variable.</td>
</tr>
<tr>
<td>BWA Delete Indexes</td>
<td>Used to delete BWA indexes.</td>
</tr>
</tbody>
</table>
### Process Name | Description
--- | ---
BWA Index Reorganization | Executes reorganization plan to distribute the indexes in a TREX system landscape to achieve a balanced memory and CPU load. The process is triggered by a BWA Index Reorganization Required incident.
BWA Index Reorganization Required | Checks the BWA system for a reorganization recommendation.
BWA Query Response Time | Monitors the query execution response time. This process uses BWA index for the query execution.
BWA Services Statistics Monitoring | Proactively monitors BWA services statistics based on thresholds defined in the BW–BWA Service Statistics Thresholds global variable.
BWA Status Check | Proactively monitors BWA status.
BWA TREX Monitor Load Statistics | Monitors BWA TREX load statistics.
BWA TREX Status Check | Monitors BWA TREX status.
Create RSDDTREX_AGGREGATES_FILL Variant | Automates the creation of variant master data required to execute the ABAP fill program RSDDTREX_AGGREGATES_FILL.
HTTP BEx URL Test | Proactively checks connectivity of the BW BEx HTTP interface. This process issues a connection test and identifies if the interface is functioning.
InfoPackage Failed | Analyzes InfoPackage data transfer requests that have not completed processing or failed in the last hour.
Process Chain Errors | Analyzes process chains that have run since the last start of the BW system. This process detects process chain errors and retrieves log file.
Search BWA Trace Logs | Searches the BWA TREX trace logs for selected keywords.
Automation for SAP BW and BWA Target Properties

The following table contains the target properties that are imported by the Automation for SAP BW and BWA automation pack. The target properties that do not have a value defined must be configured by the user prior to using them in processes.

<table>
<thead>
<tr>
<th>Target Property Name</th>
<th>Description</th>
<th>Value Defined?</th>
</tr>
</thead>
<tbody>
<tr>
<td>BW – BEx URL Test</td>
<td>Monitors the availability of specific BW BEx HTTP URLs. Enter a list of destinations to be monitored by Process Orchestrator. The entries are similar to SM59 for HTTP destinations. Destination: BEx URL Host: Port: Path: sap/bw/bex Pattern: status_code200 Pattern can be a regular expression or a substring that you are looking for in the report result. Note that it will strip off all the white spaces (blank, tab, new line) and the &quot;</td>
<td>&quot; character from the report before matching it against the pattern. Pattern example: status_code200</td>
</tr>
<tr>
<td>BW – BWA Checklist RSRV Checks Enabled</td>
<td>Indicates if RSRV checks should be performed during BWA checklist process execution.</td>
<td>Yes</td>
</tr>
<tr>
<td>BW – BWA Delay to Check Jobs Filling Indexes</td>
<td>Contains the delay in minutes to check the background job that is filling indexes.</td>
<td>Yes</td>
</tr>
<tr>
<td>BW – BWA InfoCube List for Index (variable list)</td>
<td>Contains a list of InfoCubes to index and fill.</td>
<td>No</td>
</tr>
<tr>
<td>BW – BWA Service Statistics Threshold</td>
<td>Contains the threshold values to be used for monitoring BWA Services.</td>
<td>No</td>
</tr>
<tr>
<td>BW – BWA Top InfoCubes to Monitor Status</td>
<td>Contains a list of InfoCubes to be used in the BWA Checklist process to monitor InfoCube status.</td>
<td>No</td>
</tr>
<tr>
<td>BW – BWA Top Queries to Monitor Response Time</td>
<td>Contains a list of the most important queries for detail analysis (RSRT). This global variable is used in the BWA Checklist and BWA Query Response Time processes to monitor query response time. The query response time will also be published as Process Orchestrator metrics.</td>
<td>No</td>
</tr>
<tr>
<td>BW – BWA TREX Destination</td>
<td>Contains the BWA TREX Destination.</td>
<td>No</td>
</tr>
<tr>
<td>BW – BWA Unix Target</td>
<td>Contains a reference to the BWA Unix target.</td>
<td>No</td>
</tr>
</tbody>
</table>
Chapter 2  Understanding Automation Pack Objects

Viewing Automation Pack Content and Dependencies

Automation for SAP BW and BWA Global Variables

The following table contains the global variable imported by the Automation for SAP BW and BWA automation pack.

<table>
<thead>
<tr>
<th>Global Variable Name</th>
<th>Description</th>
<th>Value Defined?</th>
</tr>
</thead>
<tbody>
<tr>
<td>BW – BWA InfoCube List for Index (lock selection)</td>
<td>Select if the index fill should be done with lock or no lock. Enter true or false.</td>
<td>Yes</td>
</tr>
<tr>
<td>BW – RSRT List of Events</td>
<td>Contains a list of RSRT events. It is updated by Cisco with all the available events.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Automating for SAP BW and BWA Knowledge Base Articles

The knowledge base articles provide information to help understand the results of an activity or process, including a summary of what has occurred, the possible cause of the results, and suggested actions to take to resolve issues with an activity. The Automation for SAP BW and BWA automation pack contains the Knowledge Base articles that are included in the SAP activities.

<table>
<thead>
<tr>
<th>Knowledge Base Article</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEx HTTP Interface Unavailable</td>
<td>Process Orchestrator could not connect to the BEx HTTP interface.</td>
</tr>
<tr>
<td>BW Accelerator Status</td>
<td>Process Orchestrator detected a BW Accelerator status alert in CCMS.</td>
</tr>
<tr>
<td>BW Checklist</td>
<td>The BW Checklist process automates the most important and frequent administration tasks for monitoring BW system health.</td>
</tr>
<tr>
<td>BW FTP Source Unavailable</td>
<td>FTP Source could not be reached.</td>
</tr>
<tr>
<td>BW InfoCube Dimension Ratio is Low</td>
<td>Process Orchestrator has detected BW infocubes whose dimension to fact table size ratio is below threshold.</td>
</tr>
<tr>
<td>BW OLAP Unavailable</td>
<td>Connection to the OLAP interface in the BW system failed.</td>
</tr>
<tr>
<td>BW Process Chain Logs</td>
<td>Process Orchestrator has detected a process chain error or termination.</td>
</tr>
<tr>
<td></td>
<td>A process chain is a sequence of processes that wait in the background for an event. Some of these processes trigger a separate event that can start other processes.</td>
</tr>
<tr>
<td>BW Query Over Threshold</td>
<td>Process Orchestrator detected BW queries over the response time threshold.</td>
</tr>
<tr>
<td>BW Report Performance</td>
<td>Process Orchestrator detected BW reports response time is above the average and/or maximum threshold.</td>
</tr>
<tr>
<td>BW Source System Extraction Error</td>
<td>Process Orchestrator has detected an error in the processing of the BW source system extraction job.</td>
</tr>
<tr>
<td>BW Source System RFC Destination Unavailable</td>
<td>RFC Destination could not connect.</td>
</tr>
<tr>
<td>BW System Check</td>
<td>Confirms that system has Business Warehouse components installed.</td>
</tr>
<tr>
<td>BWA Checklist</td>
<td>The BWA Checklist process checks BWA system health.</td>
</tr>
<tr>
<td>BWA Index Created and Filled</td>
<td>The selected infocube indexes were successfully created and filled.</td>
</tr>
<tr>
<td>BWA Index Creation or Fill Error</td>
<td>An error occurred when indexing the selected infocube.</td>
</tr>
<tr>
<td>BWA Index Status</td>
<td>The BWA Index Status activity provides the current BWA index status and version.</td>
</tr>
<tr>
<td>BWA Query Over Threshold</td>
<td>Process Orchestrator detected BWA queries over the response time threshold.</td>
</tr>
</tbody>
</table>
Chapter 2  Understanding Automation Pack Objects

Viewing Automation Pack Content and Dependencies

<table>
<thead>
<tr>
<th>Knowledge Base Article</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>BWA Status</td>
<td>Process Orchestrator detected BWA status different than green.</td>
</tr>
<tr>
<td>BWA TREX Alerts</td>
<td>Process Orchestrator detected BWA TREX alerts.</td>
</tr>
<tr>
<td>BWA TREX Service Statistics Over Threshold</td>
<td>Process Orchestrator detected TREX service statistics over threshold.</td>
</tr>
<tr>
<td>HTTP BExURL Test Failed</td>
<td>BEx URL Failed HTTP destination test executed by Process Orchestrator.</td>
</tr>
<tr>
<td>InfoPackage Request Failures</td>
<td>Process Orchestrator has detected BW InfoPackage requests in failed status.</td>
</tr>
<tr>
<td>InfoPackage Request Failures w/Error Messages</td>
<td>Process Orchestrator has detected BW InfoPackage requests in failed status.</td>
</tr>
<tr>
<td>Process Chain Error</td>
<td>Process Orchestrator has detected a process chain error.</td>
</tr>
<tr>
<td>RSMO - InfoPackage Request Failures</td>
<td>Process Orchestrator monitors BW InfoPackage requests table RSREQDONE for requests that failed or are in incompleted status.</td>
</tr>
<tr>
<td></td>
<td>An infopackage request is generated at the runtime of the data transfer process. The request is processed in the steps that have been defined for the data transfer process (extraction, transformation, filter). The monitor for the data transfer process request shows the header information, request status, and the status and messages for the individual processing steps.</td>
</tr>
<tr>
<td>RSRT - Execute Query with BWA Index</td>
<td>This activity runs a BW query with BWA index and returns debugging and performance information.</td>
</tr>
<tr>
<td>RSRT - Execute Query</td>
<td>This activity runs a BW query and returns debugging and performance information.</td>
</tr>
<tr>
<td>Top Response Time Components Over Threshold</td>
<td>The longest running components of the queries over runtime threshold are sorted and listed.</td>
</tr>
<tr>
<td>TREX Index List</td>
<td>The TREX List Indexes activity displays technical information on BWA indexes, such as the number of searchable documents, and the memory and disk space used per index.</td>
</tr>
<tr>
<td>TREX Landscape Summary</td>
<td>The TREX Landscape Summary activity provides an overview of the TREX status with information on the TREX version, operating system, and current error messages.</td>
</tr>
<tr>
<td>TREX Service Statistics</td>
<td>The TREX Services Statistics activity displays the system load on the TREX servers listed by each service type.</td>
</tr>
</tbody>
</table>

Viewing Automation Pack Dependencies

Step 1  On the Administration—Automation Packs view, select Automation for SAP BW and BWA, right-click and choose Properties.
Step 2 On the Automation for SAP BW and BWA Properties dialog box, click the **Dependencies** tab.

Step 3 Review the list of automation packs and adapters referenced by the Automation for SAP BW and BWA automation pack:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Dependency</th>
</tr>
</thead>
</table>
| Automation Packs| • Core Automation for SAP  
                  | • Core  
                  | • Assessment for SAP BWA  
                  | • Core Automation for SAP BW, BOBJ and In-Memory Computing  
                  | • Common Activities |
| Adapters        | • Core Functions Adapter  
                  | • SAP ABAP Adapter  
                  | • Generic (Microsoft OLEDB) Database Adapter  
                  | • Microsoft Windows Adapter  
                  | • Oracle Database Adapter  
                  | • IBM DB2 Database Adapter  
                  | • Microsoft SQL Server Database Adapter |

Step 4 Click **Close** to close the dialog box.
Getting Started Using the Automation Pack

Before you begin using the content that ships with the automation pack, you must create the objects in Process Orchestrator that are referenced in the processes. These objects include targets, runtime users, task rules for assignments and notifications, and target properties.

This chapter provides basic information on defining the objects. It includes the following sections:

- Creating an SAP User, page 3-2
- Creating Targets, page 3-3
- Using Task Rules for Assignments and Notifications, page 3-10
- Managing Target Properties, page 3-24

For additional information about the objects discussed in this chapter, refer to the following documentation:

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Process Orchestrator Online Help</td>
<td>Information about the objects specific to SAP ABAP Adapter (runtime user, target, and activities).</td>
</tr>
<tr>
<td>Intelligent Automation for SAP 3.0 Installation Guide</td>
<td>Information about configuring and managing the objects in Process Orchestrator specific to SAP.</td>
</tr>
</tbody>
</table>
Creating an SAP User

The Runtime Users feature is used to create a runtime user record to store the information about the user security context. The SAP User runtime user account is used for connecting to SAP ABAP system targets.

For additional information on creating and managing runtime users, see the Process Orchestrator User Guide.

Perform the following procedure to create an SAP User runtime user account.

**Step 1**
In the Definitions workspace, right-click Runtime Users and choose New > SAP User to open the New SAP User Properties dialog box.

**Step 2**
On the General tab, specify the following information:

- **Field**
  - Display name
  - User name
  - Password
  - Client
  - Description

- **Description**
  - Name for the user account. This field can populated with the information specified in the Domain and User name text fields, or you can enter a different name to display for the user account.
  - User name assigned to the user account that connects to the target.
  - Check the check box and enter the password assigned to the user account.
  - SAP client number assigned to the user account.
  - A description of the user account.

- **Note**
  - The Required Value icon displayed on a tab or page indicates that the field is required and is either missing a value or contains an invalid value.
  - No password verification is done for the simple (generic) runtime user.

**Step 3**
Click OK to close the dialog box.
Creating Targets

Before you can create or run processes, you must create the targets on which the processes will run. You use the New SAP System Wizard to create a target for an SAP system.

In addition, you must create a BWA Unix/Linux target if you want to use the BWA TREX activities that are included in the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

This section guides you through creating the targets and then configuring the references to the targets.

Note
Before you can configure an SAP ABAP system target, the dll files for SAP .NET 3.0 Connector for .NET 4.0 on x64 version 3.0.6.4 or higher must be copied to the Process Orchestrator server. See the Cisco Process Orchestrator Online Help for instructions on installing these files.

Creating SAP System Targets

Use the New SAP System Wizard to create the SAP System targets.

Step 1
In the Definitions view, right-click Targets and choose New > SAP System from the submenus to open the New SAP System Wizard Welcome panel.

Step 2
Click Next.

Note
The Required Value icon displayed on a tab or page indicates that the field is required and is either missing a value or contains an invalid value.

Note
You can only create one target for each SAP system. However, for multi-tenant environments, you can create targets for different SAP systems with the same system ID (SID).

When using the same SID for different SAP systems, you must enter the organization for each SAP system so Process Orchestrator can differentiate the alerts and incidents for each system.
### Step 3

On the System Setup panel, specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Enter a name for the SAP system. This is the name that will be displayed in the Targets pane.</td>
</tr>
</tbody>
</table>

#### System Components

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABAP application servers</td>
<td>Check this check box if the SAP system uses an ABAP connection to the application servers.</td>
</tr>
<tr>
<td>Java application servers</td>
<td><em>This option is not used for this automation pack.</em></td>
</tr>
<tr>
<td>SAP database</td>
<td><em>This option is not used for this automation pack.</em></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor as production system</td>
<td>The check box is checked by default. Certain processes will run only on production systems. If you want to monitor the system as a non-production system (development or sandbox), uncheck the check box.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Enter the group or organization within the company that owns the target.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If you are configuring multiple SAP systems with the same SID, you must specify the organization for each SAP system target.</td>
</tr>
</tbody>
</table>

### Step 4

Click **Next**.

### Step 5

On the ABAP Connection panel, specify the connection information for connecting to the SAP ABAP application server.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect using:</td>
<td></td>
</tr>
<tr>
<td>Application server</td>
<td>Choose this option to connect to the SAP system using the SAP application server connection information.</td>
</tr>
<tr>
<td>Server name</td>
<td>Name of the SAP application server.</td>
</tr>
<tr>
<td>System number</td>
<td>SAP system number.</td>
</tr>
<tr>
<td>Logon group</td>
<td>Choose this option to establish a connection using a logon group, which contains a group of SAP system instances. When a user logs on to a logon group, the message server directs the users to the server of this group that currently has the lightest load.</td>
</tr>
<tr>
<td>System ID</td>
<td>SAP system ID (SID).</td>
</tr>
<tr>
<td>Message server</td>
<td>Determines which server a user logs on to and handles the communication between the application servers. For example, transport of update requests and lock requests.</td>
</tr>
<tr>
<td>Group name</td>
<td>Name of the Logon Group to be accessed. The name entered in this field is case-sensitive.</td>
</tr>
</tbody>
</table>

---

**Note** The system information entered on this panel must be unique.
Chapter 3      Getting Started Using the Automation Pack

Creating Targets

Step 6  Click Next.

Step 7  On the Server Availability panel, specify the ABAP application servers that you want to monitor for availability and the ability to log in a user:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Router string (optional)</td>
<td>Enter the router string for accessing the SAP systems via SAPRouter. If you do not specify a router string, Process Orchestrator accesses the SAP system directly. The router string must be formatted as: /H/host01/H/host02/H/ where host01 and host02 are the SAP systems that you want to access through the SAPRouter.</td>
</tr>
<tr>
<td>Default runtime user</td>
<td>Choose the user account that contains the credentials to connect to the target from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• To view the properties for the selected runtime user, click the Properties icon.</td>
</tr>
<tr>
<td></td>
<td>• To create a new SAP User, click New &gt; SAP User. See Creating an SAP User, page 3-2 for instructions.</td>
</tr>
</tbody>
</table>

Step 8  Click Next.

Step 9  On the Completing the New SAP System Wizard panel, verify that the information is correct and click Finish to complete the procedure.
Creating BWA Unix/Linux Target

If you want to run the BWA TREX activities that are included in the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack, you must create the BWA Unix/Linux System target.

Note
For additional information on creating and managing Unix/Linux System targets, see the Cisco Process Orchestrator Online Help.

Step 1
On the Definitions workspace, right-click Targets and choose New > Unix/Linux System to open the New Unix/Linux System Properties dialog box.

Step 2
On the General tab, specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Enter a name for the Database target. This is the name that will display in the Targets pane.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Type of target.</td>
</tr>
<tr>
<td>Owner</td>
<td>User name of the owner of the target. This is typically the person who created the target. Click the Browse tool to change the owner.</td>
</tr>
<tr>
<td>Status</td>
<td>Display only. Status of the target.</td>
</tr>
<tr>
<td>Status information</td>
<td>Display only. Detailed information regarding the target status.</td>
</tr>
<tr>
<td>Organization</td>
<td>Name of the company or business unit that supports the target.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional field to enter a description for the target.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Check or uncheck the check box to enable or disable the target. The check box is checked by default.</td>
</tr>
</tbody>
</table>

Step 3
Click the Connection tab.

Note
The Required Value icon displayed on a tab or page indicates that the field is required and is either missing a value or contains an invalid value.
Step 4  On the Connection tab, specify the connection information to connect to the Unix/Linux server:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name</td>
<td>Host name or IP address of server.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number used to access the server.</td>
</tr>
</tbody>
</table>
| Prompt prefix       | Enter the command prompt prefix that will be used by the device type configurations and expects when issuing commands and connecting to the device. Adding a regex character, such as $, >, and #, at the end of a prompt in the Prompt Prefix field invalidates the command prompt prefix. Regular expressions should be placed in the appropriate Terminal Interaction Pattern fields. See Step 6 to customize the interaction patterns on the Advanced tab. Example: Unix system prompt prefix is defined by the user default login script. It usually contains username, node name or current directory name. If the user does not define anything, the prompt prefix is empty. If you connect to the terminal, and the prompt is jsmith@TBD-SH03-IT ~$, enter the regular expression that will match the entire prefix (before #) using any of the following expressions:  
  - .*TBD-SH03-IT.*  
  - \[\w+@TBD-SH03-IT.*\]  
| Default runtime user| Choose the default runtime user account that contains the credentials to connect to the target from the drop-down list. To view the properties for the selected runtime user, click the Properties tool. To create a new runtime user account, click New > [Runtime User Type] to create a new Runtime User account. |
| Enable code injection prevention | Check this check box to enable the protection which prevents code that is injected to exploit the security vulnerability. |
| Maximum allowed concurrent sessions | Enter the maximum allowed open sessions to run concurrently (default value is 3). If the user tries to open new session via Open Session activity, it will wait in a queue until there is a session available to open. |
Step 5  Click the **Authentication** tab to indicate whether the target should allow authentication based on the host system. Specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use host-based authentication</td>
<td>Check this check box to indicate that host-based authentication will be used with this target. If this check box is unchecked, then host-based authentication will not be used.</td>
</tr>
</tbody>
</table>
| Use the default host keys    | This check box becomes enabled after the *Use host-based authentication* check box is checked. Check this check box to indicate the host keys defined on the Terminal Adapter property page will be used for this target.  
If this check box is unchecked, then the user will need to load the appropriate private key to be used to validate this target. |
| Private key                  | This box becomes enabled only if the *Use the default host keys* check box is unchecked. To the right of the *display-only* field, click the **Browse** tool to launch the Load Private Key dialog box and select a private key. |

Step 6  Click the **Advanced** tab and configure the interaction patterns for the target.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Use patterns common for the following device | Click the radio button *one* of the pre-defined device targets from the drop-down list.  
- Cisco IOS Device—Select this option to use the default pattern values used by the device during the completion of a session command.  
- Unix/Linux System—Select this option to use the default pattern values indicated for a Unix or Linux system during the completion of a session command.  
To view the properties for the selected device, click the **Properties** tool.  
To create a new device, click **New > Expect Template** to create a new expect template. |
| Customize patterns for this target | Select this radio button to enable the display-only sections in order to customize the default values for the selected device type. |

Step 7  To customize the interaction patterns, complete the following fields, as necessary.
Creating Targets

Note
Click the **Reference** tool to select a defined variable or reference an object within the process from the Insert Variable Reference dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Enter the system prompt pattern in regular expression.</td>
</tr>
<tr>
<td>Error</td>
<td>Enter the error message pattern in regular expression.</td>
</tr>
<tr>
<td>Admin prompt</td>
<td>Enter the admin prompt pattern in regular expression.</td>
</tr>
</tbody>
</table>

Note
Click the **Expression** tool to add a regular expression in the field.

**Step 8**
To modify the list of login expects, click the following buttons, as necessary.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click <strong>Add</strong> to launch the Expect dialog box to configure the expect parameters to be added to the list.</td>
</tr>
<tr>
<td>Edit</td>
<td>Highlight the appropriate item and click <strong>Remove</strong> to remove the item from the list.</td>
</tr>
<tr>
<td>Remove</td>
<td>Highlight the appropriate item and click <strong>Edit</strong> to launch the Expect dialog box to modify the expect parameters in the list.</td>
</tr>
<tr>
<td>Up and Down Arrows</td>
<td>Highlight the appropriate item and then click the up or down arrow to move the item up or down in the list.</td>
</tr>
</tbody>
</table>

**Step 9**
To elevate the privilege command for login expects:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevating Privilege command</td>
<td>Check this check box and in the text field, enter the command or select the reference variable containing the command to elevate the privilege for the expect.</td>
</tr>
<tr>
<td>Elevating Privilege expects</td>
<td>Use this section to view and/or define the login expect sequence for the elevating privilege command expects.</td>
</tr>
</tbody>
</table>

**Step 10**
Click **OK** to close the dialog box.

The new target displays in the list of targets on the Definitions—Targets view.
Creating Reference to BWA Unix/Linux Target

You must now configure the BW—BWA Unix Target target reference to include the BWA Unix/Linux System target. Use the Target Properties feature to reference the targets.

**Step 1** On the Definitions workspace, click **Target Properties**.

**Step 2** Navigate to the **BW–BWA Unix Target** target reference, right-click and choose **Properties**.

**Step 3** On the Unix/Linux System Target Properties dialog box, click the **Browse** tool next to the Value field.

**Step 4** On the Select Target dialog box, select the **BWA Unix/Linux System** target and click **OK**.

**Step 5** Click **OK** to close the Unix/Linux System Target Properties dialog box.

For additional information on using Target Properties, see Managing Target Properties, page 3-24.

Using Task Rules for Assignments and Notifications

Task rules are used to manage task assignments and notifications for tasks, such as incidents and alerts, that are generated from processes. When you import the Core Automation for SAP automation pack, you are prompted to specify the default user or group who should be assigned SAP incidents. By default, this person will receive all assignments unless task rules are created to specify alternate users or groups for specific tasks.

This section guides your through configuring the task rule that ships with the Core Automation for SAP automation pack and provides instructions for creating and managing task rules.

**Note** If you do not want to create task rules for email notifications, you can use the default notification based on assignment processes that ship with the Core automation pack. These processes are disabled by default and must be enabled if you want notifications to be sent (see Enabling Notification Based on Assignment Processes, page 3-23).

Accessing Task Rules View

The task rule that ships with the Core Automation for SAP automation pack can be accessed from the Definitions—Task Rules view.

**Step 1** On the Console, select the Definitions workspace and click **Task Rules** in the navigation pane. By default, all the rules display in the Task Rules pane.

**Step 2** Click the **Filter by** link and choose **Automation Pack > [Automation Pack Name]** to filter for only the task rules that ship with the specific automation pack.
The following information about the task rules displays by default:

<table>
<thead>
<tr>
<th><strong>Column</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>The name assigned to the task rule.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Indicates whether the task rule is enabled (True) or disabled (False). A disabled task rule is unavailable for execution.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of task.</td>
</tr>
<tr>
<td>Owner</td>
<td>User name of the person or group who assigned the task rule.</td>
</tr>
<tr>
<td>Last Modified Time</td>
<td>The date and time the task rule was last modified.</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>The object or user name that last modified the task rule.</td>
</tr>
<tr>
<td>Id</td>
<td>Unique ID of the task rule.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief description of the task rule.</td>
</tr>
<tr>
<td>Type Description</td>
<td>Brief overview of the task rule type.</td>
</tr>
<tr>
<td>Created Time</td>
<td>Time at which the task rule was created.</td>
</tr>
<tr>
<td>Created Date</td>
<td>Date the task rule was created.</td>
</tr>
<tr>
<td>Automation Pack</td>
<td>Name of the automation pack associated with the task rule.</td>
</tr>
</tbody>
</table>
Configuring Task Rules

Use the Task Rules view to configure the task rule that ships with the Core Automation for SAP automation pack.

SAP Default Assignment

The Core Automation for SAP automation pack ships with the Default SAP Assignment task rule, which is used to specify the default user or group who will be assigned all SAP-related incidents unless otherwise specified in task rules. This task rule can be configured during the import process on the Default Incidents Assignee Setup panel or from the Task Rules view in the Console.

Step 1
In the Definitions workspace, click Task Rules in the navigation pane to display the task rules in the results pane.

Step 2
Click the Filter by link and choose Automation Pack, and then choose Core Automation for SAP from the drop-down list to display the task rules that ship with the automation pack.

Step 3
Right-click the SAP Default Assignment task rule and choose Properties to open the SAP Default Assignment Properties dialog box.

Step 4
Click the Assign tab to specify the user or group that should receive assignments for incidents and alerts generated by the processes.

Step 5
On the Assign tab, click Add to open the Select Assignee to Add dialog box.

Step 6
On the Select Assignee to Add dialog box, specify the assignees using one of the following methods:

- Click the Reference tool to select the appropriate variable reference containing the assignee or list of assignees from the Insert Variable Reference dialog box.
- Click the Browse tool to launch the Select User or Group dialog box to add user to the list of assignees.

Step 7
Click OK to add the assignee to the task rule.

Step 8
When you have completed adding assignees to the task rule, click OK to close the dialog box.

Creating a New Task Rule

Use the Task Rules view to create a new task rule. The procedure is the same for all types of task rules with the exception of the task-specific tab (Assign, Notify, Update) for the type of task rule you are creating.

Note
Only users with administrative rights can create task rules in Process Orchestrator.

You can create the following types of task rules:

<table>
<thead>
<tr>
<th>Task Rules</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign Task Rule</td>
<td>Assigns users to a task.</td>
</tr>
<tr>
<td>Notify Task Rule</td>
<td>Notifies users that a task has been created.</td>
</tr>
<tr>
<td>Update Task Rule</td>
<td>Specifies the properties to be updated in a task.</td>
</tr>
</tbody>
</table>
Step 1  In the Definitions workspace, right-click **Task Rules** and choose **New > [Task Rule Type]** to open the New Rule Properties dialog box.
### Step 2
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name of the task.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Shows the type of object.</td>
</tr>
<tr>
<td>Trigger</td>
<td><em>Display only.</em> Type of trigger associated with the task rule.</td>
</tr>
<tr>
<td>Owner</td>
<td>User name of the owner of the task rule. This is typically the person who created the task rule. Click the <strong>Browse</strong> tool to launch the Select User or Group dialog box to change the owner.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the task rule.</td>
</tr>
<tr>
<td>Enabled</td>
<td>The check box is checked by default to indicate that the task rule is available for execution. Uncheck the check box to disable the task rule. If the check box is unchecked, the task rule is disabled and will be unavailable for execution.</td>
</tr>
</tbody>
</table>

### Step 3
Click the **Task Types** tab to specify the types of tasks to be executed by the rule.
Step 4  Check the check box for the type of task that will execute the rule.

<table>
<thead>
<tr>
<th>Task Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert</td>
<td>Alerts reflect potential problems that a user may want to investigate and possibly diagnose the problem.</td>
</tr>
<tr>
<td>Approval Request</td>
<td>Specifies the message and choices for the assignee who is approving the task.</td>
</tr>
<tr>
<td>Guided Operation</td>
<td>Details the steps a user takes to complete an assigned task.</td>
</tr>
<tr>
<td>Incident</td>
<td>Task requires an operator to take action in order to resolve an issue.</td>
</tr>
<tr>
<td>Input Request</td>
<td>Task requires input from an individual or group.</td>
</tr>
<tr>
<td>Review</td>
<td>Task assigns a document for review.</td>
</tr>
</tbody>
</table>

Step 5  Click the Conditions tab to specify the conditions of when the task rule action is to be taken based on an evaluation of the defined conditions.

**Note**  The Required Value icon displayed on a tab or page indicates that the field is required and is either missing a value or contains an invalid value.

Step 6  On the Conditions tab, define the conditions that must be met for the rule to execute.
Defining a Basic Condition:

a. On the Basic page, click **New** to add a new property for the condition that must be met.

b. In the Property text field, click the **Reference** tool to choose a defined variable or reference an object on the Insert Variable Reference dialog box.

c. Choose the condition expression from the drop-down list.

d. Enter the condition description in the text box or click the **Reference** tool to choose a defined variable or reference an object on the Insert Variable Reference dialog box.

e. Click **New** to define additional properties, if necessary.
Defining an Advanced Condition:

a. Click the **Advanced** tab to define a specific type of condition (Compound, Prior Process Instance, Time, or Variable).

b. Click the link to modify the option for the condition equation.

c. Click **New** and choose the type of condition from the drop-down list.

d. Specify the relevant information for the type of condition selected.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND condition (all conditions must be met)</td>
<td>Click this option if an action is to be taken only when all conditions in the list are true.</td>
</tr>
<tr>
<td>OR condition (one condition must be met)</td>
<td>Click this option if an action is to be taken when one condition in the list is true.</td>
</tr>
</tbody>
</table>

e. Click **New** to define additional properties, if necessary.

**Step 7** Click the task rule specific tab (**Assign**, **Notify**, or **Update**) and specify the relevant information for the specific type of rule.
Assign Task Rule

If you are creating an Assign Task Rule, the Assign tab displays on the New Rule Properties dialog box. On the Assign tab, specify the assignees for task rule.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click this button to launch the Select Assignee to Add dialog box to specify the assignees. On the Select Assignee to Add dialog box, use one of the following methods to specify the assignee:</td>
</tr>
<tr>
<td></td>
<td>• Click the Reference tool to select the appropriate variable reference containing the assignee or list of assignees from the Insert Variable Reference dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Click the Browse tool to launch the Select User or Group dialog box and add user to the list of assignees.</td>
</tr>
<tr>
<td>Edit</td>
<td>Select the appropriate assignee in the list and click this button to view or modify the assignee of the task rule.</td>
</tr>
<tr>
<td>Remove</td>
<td>Select the appropriate assignee and click this button to remove the assignee from the list.</td>
</tr>
<tr>
<td>Remove All</td>
<td>Click this button to remove all specified assignees from the list.</td>
</tr>
</tbody>
</table>
Notify Task Rule

If you are creating a Notify Task Rule, the Notify tab displays on the New Rule Properties dialog box. On the Notify tab, specify the recipients of the notification that the task rule has executed. You can add individual recipients or include a notification recipient list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add notification recipients</td>
<td>Displays list of users to be notified by the task rule.</td>
</tr>
<tr>
<td></td>
<td>• Add—Click this button to launch the Select Notification Recipient to Add dialog box to specify the recipients.</td>
</tr>
<tr>
<td></td>
<td>• Edit—Select the appropriate recipient in the list and click this button to view or modify the recipient of the task rule.</td>
</tr>
<tr>
<td></td>
<td>• Remove—Select the appropriate recipient in the list and click this button to remove the recipient from the list.</td>
</tr>
<tr>
<td></td>
<td>• Remove All—Click this button to remove all specified recipients from the list.</td>
</tr>
<tr>
<td>Add notification recipient list</td>
<td>Click the Reference tool to select the appropriate variable reference containing list of recipients from the Insert Variable Reference dialog box.</td>
</tr>
</tbody>
</table>

Update Task Rule

If you are creating an Update Task Rule, the Update tab displays on the New Rule Properties dialog box.

On the Update tab, specify the properties to be updated after the task rule has executed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click this button to add a new property to the Properties to update area.</td>
</tr>
<tr>
<td>Remove</td>
<td>Click this button to remove the last property added to the Properties to update area.</td>
</tr>
<tr>
<td>Property</td>
<td>From the Property drop-down list, choose the item to update within the task. The properties displayed depend on the selected item.</td>
</tr>
</tbody>
</table>
Managing Task Rule Definitions

This section provides instructions on modifying task rules in the Definitions—Task Rule view. Only users with administrative rights or authoring rights can modify task rules in Process Orchestrator.

**Note**
For additional information on managing task rules, see the Process Orchestrator User Guide.

Enabling a Task Rule

A task rule is enabled by default. If a task rule is manually disabled, the task rule must be enabled before it is available for execution.

On the Definitions—Task Rules view, select the task rule and then use one of the following methods to enable it:

- On the Results pane, right-click and choose **Enable**.
- Or-
- On the Details pane, select **Click here to enable**.

The Enabled column on the Results pane changes to True. If necessary, click the **Refresh** tool to update the view.

Disabling a Task Rule

Disabling a task rule prevents the item from being available for execution. The disabled task rule is not removed from the list of task rules on the Definitions—Task Rules Results pane.

On the Definitions—Task Rule view, select the task rule and then use one of the following methods to disable it:

- On the Results pane, right-click and choose **Disable**.
-or-

- On the Details pane, select **Click here to disable**.

The Enabled column on the results pane changes to False. If necessary, click the **Refresh** tool to update the view.
Creating a Copy of a Task Rule

The copy option is used when the user wants to leverage an existing task rule to define a new task rule using existing properties.

Step 1
On the Definitions—Task Rules view, select the appropriate task rule, right-click and choose **Copy**.

Step 2
On the Results pane, right-click and choose **Paste**.
A copy of the defined task rule is pasted onto the Results pane.

Step 3
To rename the copied task rule or other properties, right-click and choose **Properties**.

Step 4
Modify the task rule name, as appropriate, and click **OK** to close the dialog box.

Sorting Task Rules

The task rules are executed according to the order they are listed on the Definitions—Task Rules view. You should sort the task rules based on the order in which you want them to execute.

**Note**
All task rules will execute even if there is more than one task rule assigned for the same condition. For example, if you have two assignment rules for the same incident, both rules will be executed in the order listed in the Task Rules view.

On the Definitions—Task Rules view, select the task rule and use one of the following methods to move it to the desired position in the list:

- Drag and drop the task rule into the appropriate position in the list.
- On the Actions toolbar, click **Move Up** or **Move Down**.
- Click the Actions menu and choose **Move Up** or **Move Down**.
- Right-click and choose **Move Up** or **Move Down**.

The list of task rules are sorted according to the selected action.

Deleting a Task Rule

Use the Definitions—Task Rules view to delete task rules that are no longer used.

Step 1
On the Definitions—Task Rules view, select the task rule, right-click and choose **Delete**.

Step 2
On the Confirm Delete dialog box, click **Yes** to confirm the deletion.
Enabling Notification Based on Assignment Processes

If you want to have emails sent to whoever is assigned to a task but do not want to create notification task rules, you can enable the processes that ship with the Core automation pack that send emails based on assignment.

When these processes are enabled, the user or user group who was assigned to tasks will receive the email notification.

**Step 1**
In the Definitions workspace, click **Processes**.

**Step 2**
Click the **Filter by** link and choose **Automation Pack > Core** to filter for the processes that ship with the Core automation pack.

**Step 3**
Right-click the appropriate **Notification Based on Assignment** process and choose **Enable**.

The following processes are for notification based on assignment:

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Alert Notification Based on Assignment</td>
<td>Sends email when an alert gets assigned.</td>
</tr>
<tr>
<td>Default Approval Request Notification Based on Assignment</td>
<td>Sends email when an approval request gets assigned.</td>
</tr>
<tr>
<td>Default Change Request Notification Based on Assignment</td>
<td>Sends email when a change request gets assigned.</td>
</tr>
<tr>
<td>Default Guided Operation Request Notification Based on Assignment</td>
<td>Sends email when a guide operation request gets assigned.</td>
</tr>
<tr>
<td>Default Incident Notification Based on Assignment</td>
<td>Sends email when an incident gets assigned.</td>
</tr>
<tr>
<td>Default Input Request Notification Based on Assignment</td>
<td>Sends email when an input request gets assigned.</td>
</tr>
<tr>
<td>Default Review Request Notification Based on Assignment</td>
<td>Sends email when a review request gets assigned.</td>
</tr>
</tbody>
</table>
Managing Target Properties

The Automation for SAP BW and BWA processes use target properties to override certain variable properties assigned to targets. For example, target properties can be used to specify a different target when certain conditions occur.

This section provides information on configuring target properties.

Accessing Target Properties

The target properties that ship with the Automation for SAP BW and BWA automation pack can be accessed from the Definitions—Target Properties view.

Step 1

On the Console, select the Definitions workspace and click Target Properties in the navigation pane. By default, all the properties display in the Target Properties pane.

The following information about the target properties displays by default:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name of the target property.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the target property.</td>
</tr>
<tr>
<td>Value</td>
<td>Value assigned to the target property.</td>
</tr>
<tr>
<td>Data Type</td>
<td>Type of value being used for the target property (Boolean, Encrypted String, Identity, Numeric, String, Table).</td>
</tr>
<tr>
<td>Automation Pack</td>
<td>Name of the automation pack that provides the target property.</td>
</tr>
<tr>
<td>Customizable</td>
<td>Indicates the customization setting for the target property in the automation pack.</td>
</tr>
<tr>
<td>Target Types</td>
<td>Indicates the targets associated with the target property.</td>
</tr>
<tr>
<td>Last Modified Time</td>
<td>Date and time the variable was last modified.</td>
</tr>
<tr>
<td>Last Modified By</td>
<td>Name of the user who last modified the target property.</td>
</tr>
<tr>
<td>Id</td>
<td>Unique ID of the target property.</td>
</tr>
<tr>
<td>Owner</td>
<td>User name of the owner of the target property. This is typically the person who created the target property.</td>
</tr>
<tr>
<td>Created Time</td>
<td>Date and time the target property was created.</td>
</tr>
<tr>
<td>Created By</td>
<td>User name of the person who created the target property.</td>
</tr>
</tbody>
</table>

Step 2

Click the Filter by link and choose Automation Pack > Automation for SAP BW and BWA to filter for only the target properties that ship with the specific automation pack.
Configuring Target Properties

You use the Target Properties dialog box to view or modify the target property. You access the properties from the Definitions—Target Properties view.

The following section provides information on configuring target properties that ship with the Automation for SAP BW and BWA automation pack.

**Step 1**
On the Target Properties pane, right-click [Target Property] and choose Properties.

**Step 2**
On the General tab, review the information in the Description field to determine the values that need to be specified for the target property.

**Step 3**
Click the Value tab to view or modify the default value for all targets.

**Note**
The tab in the second position will depend on the variable type. See the Process Orchestrator User Guide for instructions on configuring the different types of target properties.

**Step 4**
Click in the cell to specify the default value or change the default value for all SAP targets.

**Step 5**
Click the Target Values tab to specify the targets that should be used to override the default value.

**Step 6**
Click New to add a new target override.

**Step 7**
On the Target Property Value dialog box, click Add to choose the target (SAP system) to be used for the override value. This is the SAP system that will be monitored for a value other than the default value.

**Step 8**
Select the SAP system and click OK.

**Step 9**
On the Target Property Value dialog box, enter the information in the Value area to be used for the specified target and then click OK.

The target override displays on the Target Values tab.

**Step 10**
Click OK to close the dialog box and save your changes.

**Note**
The Target Types tab is only available if you have explicit rights to the object. See the Process Orchestrator User Guide for information on using this property page.
Managing Automation for SAP BW and BWA Processes

This chapter provides information on using the product, specific to the Automation for SAP BW and BWA automation pack. It includes information on accessing the Automation for SAP BW and BWA processes and filtering for specific processes, managing the SAP BW and BWA processes, starting a process, and viewing a running process, its results, and the automation summary generated by the process.

It includes the following sections:

- Accessing Automation for SAP BW and BWA Processes, page 4-2
- Managing SAP Processes, page 4-2
- Running Processes, page 4-6
- Viewing Process Results, page 4-8
- Viewing Automation Summary, page 4-9

**Note**
Before you can run the Automation for SAP BW processes, you must configure the objects that are referenced by the processes and activities. See the *Intelligent Automation for SAP 3.0 Installation Guide* for information on configuring the SAP-related objects in Process Orchestrator.
Accessing Automation for SAP BW and BWA Processes

The processes that ship with the product can be accessed from the Definitions—Processes view.

**Step 1**
On the Console, select the Definitions workspace and click **Processes** in the navigation pane. By default, all the processes display in the Processes pane.
If you have multiple automation packs installed, you can filter the processes to display the processes specific to the automation pack.

**Step 2**
In the upper portion of the Processes pane, click the **Filter by** link and choose **Automation Pack**.

**Step 3**
In the drop-down list, choose **Automation for SAP BW and BWA**.
The processes display in the Processes pane.

Filtering Processes by Category

You can also filter the processes by category to find a specific process.

**Step 1**
In the upper portion of the Processes pane, click the **Filter by** link and choose **Category**.

**Step 2**
In the drop-down list, choose **SAP BW**.

**Step 3**
Scroll to the process.

Managing SAP Processes

This section provides information on managing the SAP BW and BWA processes, including:

- Enabling and disabling processes
- Enabling and disabling the process archival feature
- Modifying a process schedule

Enabling a Process

Some of the processes that ship with the automation packs are disabled by default to reduce the load on the server. These processes must be enabled before the other processes can be successfully executed.

Perform the following steps to enable a process.

**Step 1**
In the Processes view, navigate to the process that you want to enable (disabled processes appear dimmed).

**Step 2**
Use one of the following methods to enable the process:

- Right-click the process and choose **Enable** from the submenu.
In the Process Editor, click the General tab and then check the Enabled check box. Click the Save tool to save your changes to the process and close the Process Editor.
Disabling a Process

Disabling a process prevents the process from executing. You may want to disable some processes to reduce the load on your server or while you are modifying the process definition.

Perform the following steps to disable a process.

**Step 1**  
In the Processes view, navigate to the process that you want to disable.

**Step 2**  
Use one of the following methods to disable the process:

- Right-click the process and choose **Disable** from the submenu.
- In the Process Editor, click the **General** tab and then uncheck the **Enabled** check box. Click the **Save** tool to save your changes to the process and close the Process Editor.

Modifying Process Instance Archival

Cisco Process Orchestrator provides an option in the process definition that allows you to choose whether or not to archive process and activity execution in the Process OrchestratorProcess database. Disabling the archive option helps improve performance and minimizes the size of the database. It is also useful when debugging the execution of processes.

The automation packs shipped by Cisco normally have the archival functionality disabled by default for the SAP processes. If you want to view the execution of a process and its activities, or view the process instances after a process has completed, you must enable the archival functionality in the process definition.

**Step 1**  
In the Processes view, navigate to the process you want to flag for archival.

**Step 2**  
Right-click the process and choose **Edit** from the submenu.

**Step 3**  
On the process Properties dialog box, click the **Options** tab.

**Step 4**  
On the **Options** tab, click one of the following radio buttons to indicate how you want to archive the process instance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Never archive any instances</td>
<td>Click this radio button to indicate that the process should not be stored upon completion.</td>
</tr>
<tr>
<td>Only archive failed instances</td>
<td>Click this radio button to indicate that only failed instances should be archived.</td>
</tr>
<tr>
<td>Archive all completed instances</td>
<td>Click this radio button to indicate that the process should be stored upon completion.</td>
</tr>
<tr>
<td>Archive based on condition</td>
<td>Click this radio button to indicate that the process should be stored based on the condition (True/False) selected. Click the <strong>Browse</strong> tool to launch the Archive Condition dialog box and select the condition.</td>
</tr>
</tbody>
</table>
Modifying a Process Schedule

Many of the processes that ship with the automation packs are triggered by a schedule. You can modify when the process will be executed by disabling the existing schedule and then creating a new schedule for the process. You use the process Properties dialog box to modify the process schedule.

Perform the following steps to assign a new schedule to a process.

Step 1  In the Processes view, navigate to the process that you want to modify.

Step 2  Right-click the process and choose Edit from the submenu.

Step 3  On the process Properties dialog box, click the Triggers tab.

Step 4  On the Triggers tab, right-click the current Schedule and choose Disable from the submenu.

Step 5  Click New > Schedule to open the Schedule Properties dialog box to create a new schedule for this process.

Step 6  On the Schedule Properties dialog box, specify the criteria for the new schedule and click OK.

Note  For information on creating schedules, see “Managing Triggers” in the Process Orchestrator User Guide.

The newly created schedule displays on the Triggers tab and is enabled.

Step 7  Click the Save tool to save your changes to the process and close the Process Editor.
Running Processes

The processes that ship with the product will run based on the trigger that was defined in the process definition. For processes that are triggered by a schedule, you can also manually start the process at any time (adhoc).

Note
You can only view a running process and the process instances for processes that have the Archive all completed instances option enabled. See Modifying Process Instance Archival, page 4-4 for information on enabling the archival feature on a specific process.

Starting a Process

Step 1
In the Processes view, right-click the process and choose Start Process.

The Confirm Start Process dialog box displays.

This process is defined to run on systems in the All SAP ABAP target group. In this example, we will override the default target and select a specific system on which to run the process.

Step 2
On the Confirm Start Process dialog box, check the Override target (All SAP ABAP) check box to expand the fields on the dialog box.

Step 3
Click the Target radio button and then click the Browse tool to open the Select Target dialog box.

Step 4
Select the target in the list and then click OK.

Step 5
On the Confirm Start Process dialog box, click OK to start the process.

Viewing Running Process

After starting the process, you can use the Process Viewer to view the process as it runs through each activity.

**Note** You can only view a running process and the process instances for processes that have the Archive all completed instances option enabled. See Modifying Process Instance Archival, page 4-4 for information on enabling the archival feature on a specific process.

**Step 1** On the Start Process Results dialog box, right-click the process and choose **Observe**.

The Process Viewer displays the process workflow.

**Step 2** View the process as it proceeds through the workflow.

The activities within the process workflow will change to green as they complete (succeed). If an activity fails, an incident is created.

**Step 3** When the process completes, close the Process Viewer and proceed to Viewing Process Results, page 4-8.
Viewing Process Results

After a process completes, you can view the results in the Operations workspace. This section guides you through viewing the results from running the BW Checklist process.

Note
You can only view a running process and the process instances for processes that have the Archive all completed instances option enabled. See Modifying Process Instance Archival, page 4-4 for information on enabling the archival feature on a specific process.

Accessing Process View

Step 1
On the Console, select the Operations workspace.

Step 2
In the navigation pane, expand Process Views and click View Adhoc (since the BW Checklist process was manually executed).

Step 3
Using the Filter by link, choose Category and then choose SAP BW from the drop-down list.

Step 4
Scroll to the BW Checklist process and select it.

Step 5
In the View Results pane, expand the BW Checklist process to view each activity in the process workflow.

Step 6
Review the status of the process and each activity within the process to verify that it has succeeded.

Viewing Activity Results

You can view the results of a specific activity within the process using the Activity Instance Properties dialog box. In this example, we will view the results of the Get Database Type activity, which retrieves information about the SAP database associated with the SAP system.

Step 1
In the View Results pane, scroll to the Get Database Type activity.

Step 2
Right-click Get Database Type and choose Properties.

Step 3
On the Get Database Type Properties dialog box, click the Values tab.

Step 4
When you have completed reviewing the results, click Close to close the dialog box.

Viewing Incidents

When a process detects an issue that requires action, an incident is generated. If you have configured the product to send notifications to a specific person in your organization, that person will receive an email notification whenever an incident is generated. You can also view these incidents in the Task Views on the Operations workspace.

In this example, we will view the incidents that were generated from the BW Checklist process.
Chapter 4  Managing Automation for SAP BW and BWA Processes

Viewing Automation Summary

When incidents are generated, Process Orchestrator delivers an online Automation Summary that details the analysis that was performed to identify a situation that may require action. It also shows relevant diagnostic and state information captured while performing the situation analysis, and provides a recommended resolution for the situation.

You can access the Automation Summary from the Tasks View on the Operations workspace.

---

**Viewing Automation Summary**

**Step 1** On the Operations workspace, expand Task Views in the navigation pane and click View Incidents.

**Step 2** In the View Incidents pane, click the View all tasks from the Task Assignee drop-down list to display all the incidents in the View Results pane.

**Step 3** To view a specific incident, right-click the incident and choose Open.

The Incident Report displays in your web browser.
Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content

The Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack contains the default content to support SAP BW, BOBJ and In-Memory Computing automation packs. This appendix describes the content included in the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack. It includes the following sections:

- Automation Pack Content, page A-1
- Automation Pack Dependencies, page A-4
- Core Automation for SAP BW, BOBJ and In-Memory Computing Activities, page A-4
- Defining the BWA TREX Activities, page A-10

Automation Pack Content

Use the automation pack Properties dialog box to view the content (objects) included in the automation pack. For instructions on accessing the automation pack properties, see Accessing Automation Pack Properties, page 2-1.

Core Automation for SAP BW, BOBJ and In-Memory Computing Processes

The following table contains the process that is imported by the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOBJ Process Execution Error</td>
<td>Raises an incident when there are errors in the execution of process activities contained in the BOBJ automation packs.</td>
</tr>
</tbody>
</table>
Core Automation for SAP BW, BOBJ and In-Memory Computing Activities

The Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack contains additional activities for use in the SAP BW, BOBJ and In-Memory Computing processes. These are additional activities that display in the Process Editor toolbox after the user has imported the automation packs.

See Core Automation for SAP BW, BOBJ and In-Memory Computing Activities, page A-4 for information on the activities and how to use them.

Core Automation for SAP BW, BOBJ and In-Memory Computing Target Properties

The following table contains the SAP BW, BOBJ and In-Memory Computing target properties that are imported by the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

<table>
<thead>
<tr>
<th>Target Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BWA.Direct TREX.Path to Scripts</td>
<td>Contains the path to the Process Orchestrator scripts that were installed to the TREX servers.</td>
</tr>
<tr>
<td>BWA.TREX.Index Query</td>
<td>Contains the custom defined TREX and the response time threshold values to be used for monitoring TREX in a non-SAP environment.</td>
</tr>
<tr>
<td>BWA.TREX.Load Metrics</td>
<td>Contains the thresholds for system workload metrics.</td>
</tr>
<tr>
<td>BWA.TREX.Long Running Threads – Types to Exclude</td>
<td>Contains the thread types that should not be monitored for long running threads.</td>
</tr>
<tr>
<td>BWA.TREX.Long Running Threads Thresholds</td>
<td>Contains the thresholds for long running threads. Thread types can be excluded from monitoring using the target property BWA.TREX.Long Running Threads – Types to Exclude.</td>
</tr>
<tr>
<td>BWA.TREX.Service Statistics Threshold</td>
<td>Contains the threshold values to be used for monitoring TREX Service Statistics in a non-SAP environment.</td>
</tr>
</tbody>
</table>

For instructions on configuring target properties, see Managing Target Properties, page 3-24.
Core Automation for SAP BW, BOBJ and In-Memory Computing Global Variables

The following table contains the SAP BW, BOBJ and In-Memory Computing global variables that are imported by the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

<table>
<thead>
<tr>
<th>Global Variable Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOBJ – Alert Suppression Time</td>
<td>Contains the duration that duplicate BOBJ alerts will be suppressed. After this time, a new alert and incident will be created.</td>
</tr>
</tbody>
</table>

For instructions on configuring global variables, see the Process Orchestrator User Guide.

Core Automation for SAP BW, BOBJ and In-Memory Computing Target Groups

The Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack provides the target groups that are used by the processes. Most of the target groups are automatically populated with members when the targets are configured. For those that are not automatically populated, you must manually add the members.

The following table contains the target groups that are imported by the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

<table>
<thead>
<tr>
<th>Target Group Name</th>
<th>Description</th>
<th>Automatically Populated with Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct TREX Servers</td>
<td>All terminal targets for TREX Servers.</td>
<td>No</td>
</tr>
</tbody>
</table>

For information on adding members to target groups, see the Process Orchestrator User Guide.
Automation Pack Dependencies

Use the Dependencies tab on the automation pack Properties dialog box to view the automation packs and adapters referenced by the objects in the automation pack. These objects must be installed prior to importing the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

For instructions on accessing the automation pack properties, see Accessing Automation Pack Properties, page 2-1.

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Dependency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automation Packs</td>
<td>- Core</td>
</tr>
</tbody>
</table>
| Adapters | - Core Functions Adapter  
- Terminal Adapter |

Core Automation for SAP BW, BOBJ and In-Memory Computing Activities

The following table contains the activities that are imported by the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| BWA TREX – Cancel Running Reorganization | Stops the index reorganization process.  
| BWA TREX – Continue Reorganization | Continues a stopped index reorganization process.  
| BWA TREX – Delete All Indexes | Deletes all indexes from the BWA instance.  
See BWA TREX—Delete All Indexes Activity, page A-12. |
| BWA TREX – Delete Index | Deletes a specific index from the BWA instance.  
| BWA TREX – Execute Query | Executes a TREX query against a specified index to return query response time.  
| BWA TREX – Get Alert Details | Displays current alert details.  
| BWA TREX – Get Alerts | Displays current alert summary.  
| BWA TREX – Get Index Usage | Returns index usage and statistical data.  
See BWA TREX—Get Index Usage Activity, page A-17. |
<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BWA TREX – Get Indexes</td>
<td>Retrieves technical data for all indexes for a TREX system.</td>
</tr>
<tr>
<td></td>
<td>See BWA TREX—Get Indexes Activity, page A-17.</td>
</tr>
<tr>
<td>BWA TREX - Get Landscape Summary</td>
<td>Retrieves a summary of the overall BWA landscape system health.</td>
</tr>
<tr>
<td>BWA TREX – Get Last Reorganization Plan</td>
<td>Displays details of the last index reorganization plan.</td>
</tr>
<tr>
<td>BWA TREX – Get Load Metrics</td>
<td>Retrieves current TREX system workload metrics.</td>
</tr>
<tr>
<td>BWA TREX – Get Loaded Indexes</td>
<td>Displays the indexes that are currently online in the BWA instance.</td>
</tr>
<tr>
<td>BWA TREX – Get Long Running Threads</td>
<td>Retrieves a list of currently active long running TREX engine threads.</td>
</tr>
<tr>
<td>BWA TREX – Get Next Reorganization Plan</td>
<td>Displays details of the next index reorganization plan.</td>
</tr>
<tr>
<td>BWA TREX – Get Reorganization Summary</td>
<td>Displays current state of index reorganization requirements and suggested plan.</td>
</tr>
<tr>
<td>BWA TREX - Get Service Statistics</td>
<td>Retrieves current TREX engine service runtime statistics, such as CPU, memory and response time.</td>
</tr>
<tr>
<td>BWA TREX – Preload Index</td>
<td>Preloads an index into the instance array memory.</td>
</tr>
<tr>
<td>BWA TREX – Restart Service</td>
<td>Restarts individual TREX service processes.</td>
</tr>
<tr>
<td></td>
<td>See BWA TREX—Restart Service Activity, page A-27.</td>
</tr>
<tr>
<td>BWA TREX – Start Reorganization</td>
<td>Starts the execution of the index reorganization.</td>
</tr>
<tr>
<td></td>
<td>See BWA TREX—Start Reorganization Activity, page A-29.</td>
</tr>
</tbody>
</table>
Appendix A      Core Automation for SAP BW, BOBJ and In-Memory Computing Activities

Core Automation for SAP BW, BOBJ and In-Memory Computing Activities

Defining an Activity

Use the following steps to define an activity in the Process Editor. The property pages that display depend on the activity. Refer to the appropriate section for instructions on completing the activity property pages.

Step 1
On the Toolbox pane, navigate to the appropriate section, click the activity and drag it onto the Workflow pane.

The Activity Properties dialog box displays.

Note
The Required Value icon displayed on a tab or page indicates that the field is required and is either missing a value or contains an invalid value.

Click the Reference tool to select a defined variable or reference an object within the process. For additional information, see the Process Orchestrator User Guide.

Step 2
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3
Click the Activity-specific tab (typically, Inputs) and enter the required information. See the appropriate section in this chapter for instructions on completing the fields on the activity-specific tab.
Step 4 Click the **Target** tab to specify the process target. You can use the process target or override it and specify a different target for the specific activity.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execute on the process target</td>
<td>Click this radio button to use the same target that was specified for the process.</td>
</tr>
<tr>
<td>Execute on activity target</td>
<td>Click this radio button to indicate that the activity should execute against a target selected in an activity within the process. Choose the activity from the drop-down list.</td>
</tr>
<tr>
<td>Execute on this target</td>
<td>Click this radio button and then click the <strong>Browse</strong> tool to launch the Select Target dialog box and choose a specific target on which to execute the activity.</td>
</tr>
<tr>
<td></td>
<td>The targets that display in the Select Target dialog box are targets already defined in Process Orchestrator.</td>
</tr>
<tr>
<td></td>
<td>To view the properties for the selected target, click the <strong>Properties</strong> tool.</td>
</tr>
<tr>
<td>Execute on this target reference</td>
<td>Click this radio button and then click the <strong>Reference</strong> tool to select the target reference property on which to execute the activity.</td>
</tr>
<tr>
<td></td>
<td>You can also click the <strong>Browse</strong> tool to launch the Select Target dialog box and choose a specific target on which to execute the activity.</td>
</tr>
<tr>
<td>Execute on this target group</td>
<td>Click this radio button and then click the <strong>Browse</strong> tool to launch the Select Target Group dialog box and choose a specific target on which to execute the activity.</td>
</tr>
<tr>
<td></td>
<td>The target groups that display in the Select Target Group dialog box are target groups already defined in Process Orchestrator.</td>
</tr>
<tr>
<td></td>
<td>To view the properties for the selected target group, click the <strong>Properties</strong> tool.</td>
</tr>
<tr>
<td></td>
<td>From the Choose a target using this algorithm drop-down list, select the algorithm which will determine the target to execute from the eligible target group.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The available algorithms that display depend on the selected activity.</td>
</tr>
</tbody>
</table>
Step 5  Click the **Credentials** tab to specify the runtime user whose credentials should be used for process execution:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use target's default runtime user</td>
<td>Click this radio button to use the default runtime user for the target that is specified in the activity.</td>
</tr>
<tr>
<td>Use process runtime user</td>
<td>Click this radio button to use the credentials for the runtime user that was specified for the process.</td>
</tr>
</tbody>
</table>
| Override process runtime user | Click this radio button to specify different credentials than what are used for the process. The selected runtime user overrides the runtime user that was specified for the process.  
  
  - To view the properties for the selected runtime user, click the **Properties** tool.  
  - To create a runtime user record for the process, click **New**.  
  
  For additional information on creating a runtime users, see the *Process Orchestrator User Guide*. |

Step 6  Click the **Knowledge Base** tab to specify a knowledge base article for the activity. The following information displays:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge base</td>
<td>Knowledge base article associated with the activity.</td>
</tr>
<tr>
<td>Summary</td>
<td>Brief description of the issue.</td>
</tr>
<tr>
<td>Possible Cause</td>
<td>Explanation of the condition that may be causing the issue.</td>
</tr>
<tr>
<td>Possible resolution</td>
<td>List of actions that can be performed to attempt to resolve the issue.</td>
</tr>
<tr>
<td>Related information</td>
<td>Additional information related to the issue.</td>
</tr>
</tbody>
</table>

a. If the knowledge base article is not displayed by default, click the **Browse** tool in the Knowledge Base field.

b. On the Select Knowledge Base dialog box, select the appropriate knowledge base article in the list and click **OK**.

**Note**  Click **New** to create a new knowledge base article. For additional information on knowledge base articles, see the *Process Orchestrator User Guide*.

Step 7  Click the **Result Handlers** tab to specify condition branches for the activity.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds a condition branch.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the condition branch from the activity.</td>
</tr>
</tbody>
</table>
Appendix A  Core Automation for SAP BW, BOBJ and In-Memory Computing Automation Pack Content

Core Automation for SAP BW, BOBJ and In-Memory Computing Activities

Step 8  Click the Save tool to save the activity definition.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Up</td>
<td>Moves the condition up one position in the list of conditions.</td>
</tr>
<tr>
<td>Move Down</td>
<td>Moves the condition down one position in the list of conditions.</td>
</tr>
</tbody>
</table>

Viewing Activity Results

When an activity is executed, results are displayed in the Operations workspace activity instance view.

Step 1  In the Operations workspace, expand the Activity Views folder and click the view that represents how the process was executed (for example, View Adhoc, if the process was manually executed).

Step 2  In the View Results pane, expand the process, and double-click the activity instance or right-click and choose Observe.

Step 3  On the Process Viewer, ensure that Properties is enabled in the View menu, and then click the activity in the workflow to display the activity instance properties.

Step 4  If the activity required input values, click the Inputs tab to view the display-only properties of the activity.

Step 5  Click the Outputs tab to view the results of the activity.

Step 6  When you have completed viewing the properties, close the Process Viewer.
Defining the BWA TREX Activities

This section provides instructions for defining the BWA TREX activities.

BWA TREX—Cancel Running Reorganization Activity

Use the BWA TREX—Cancel Running Reorganization activity to stop an index reorganization process.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Cancel Running Reorganization** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Inputs** tab.

**Step 4**
In the Timeout (secs) text field, specify the number of seconds to allow for the SSH call to complete its operation on BWA.

**Step 5**
Complete the appropriate information in the following tabs:

- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the **Save** tool to save the activity definition.
BWA TREX—Continue Reorganization Activity

Use the BWA TREX—Continue Reorganization activity to continue an index reorganization process that has been stopped.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Continue Reorganization** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Inputs** tab.

**Step 4**
In the Timeout (secs) text field, specify the number of seconds to allow for the SSH call to complete its operation on BWA.

**Step 5**
Complete the appropriate information in the following tabs:
- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the **Save** tool to save the activity definition.
BWA TREX—Delete All Indexes Activity

Use the BWA TREX—Delete All Indexes activity to delete all indexes from the BWA instance.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Delete All Indexes** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Complete the appropriate information in the following tabs:

- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 4**
Click the **Save** tool to save the activity definition.
Defining the BWA TREX Activities

BWA TREX—Delete Index Activity

Use the BWA TREX—Delete Index activity to delete a specific index from the BWA instance.

Step 1
On the Toolbox pane, click the **BWA TREX—Delete Index** activity and drag it onto the Workflow pane.

Step 2
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3
Click the **Inputs** tab.

Step 4
On the Inputs tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index ID</td>
<td>Index technical name for the index to be deleted.</td>
</tr>
<tr>
<td>Timeout (sec)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

Step 5
Complete the appropriate information in the following tabs:
- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6
Click the **Save** tool to save the activity definition.

BWA TREX—Execute Query Activity

Use the BWA TREX—Execute Query activity to execute a TREX query against a specific index. This activity returns the query response time.

Step 1
On the Toolbox pane, click the **BWA TREX—Execute Query** activity and drag it onto the Workflow pane.

Step 2
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index ID</td>
<td>Index technical name for the index to be deleted.</td>
</tr>
<tr>
<td>Timeout (sec)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>


Defining the BWA TREX Activities

Step 3  Click the Inputs tab.

Step 4  On the Inputs tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Options to designate the TREX query and index to be executed.</td>
</tr>
<tr>
<td>Timeout (sec)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

Step 5  Complete the appropriate information in the following tabs:

- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6  Click the Save tool to save the activity definition.
BWA TREX—Get Alert Details Activity

Use the BWA TREX—Get Alert Details activity to retrieve current alert details.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Get Alert Details** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Inputs** tab.

**Step 4**
In the Timeout (secs) text field, specify the number of seconds to allow for the SSH call to complete its operation on BWA.

**Step 5**
Complete the appropriate information in the following tabs:
- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the **Save** tool to save the activity definition.

BWA TREX—Get Alerts Activity

Use the BWA TREX—Get Alerts activity to retrieve a list of alerts.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Get Alerts** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Inputs** tab.
Step 4  On the Inputs tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age (minutes)</td>
<td>Retrieve alerts that have occurred within the last X minutes indicated in this field.</td>
</tr>
<tr>
<td>Severity</td>
<td>Severity level of alerts to be retrieved (Red, Yellow, Green, Grey, All).</td>
</tr>
<tr>
<td>Timeout (sec)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

Step 5  Complete the appropriate information in the following tabs:

- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6  Click the **Save** tool to save the activity definition.
BWA TREX—Get Index Usage Activity

Use the BWA TREX—Get Index Usage activity to return index usage and statistical data.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Get Index Usage** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Inputs** tab.

**Step 4**
Specify the following information:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>Date from which to begin collecting index usage data.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time from which to begin collecting for the index usage data.</td>
</tr>
<tr>
<td>Index Name(s)</td>
<td>Complete index name of the index or enter * to retrieve usage data from all indexes.</td>
</tr>
<tr>
<td>Timeout (secs)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

**Step 5**
Complete the appropriate information in the following tabs:
- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the **Save** tool to save the activity definition.

BWA TREX—Get Indexes Activity

Use the BWA TREX—Get Indexes activity to retrieve a list of the loaded indexes.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Get Indexes** activity and drag it onto the Workflow pane.
Step 2  On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3  Click the Inputs tab.

Step 4  Specify the following information:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Name</td>
<td>Complete name of the index or enter * to retrieve all indexes.</td>
</tr>
<tr>
<td>Timeout (secs)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

Step 5  Complete the appropriate information in the following tabs:
- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6  Click the Save tool to save the activity definition.
BWA TREX—Get Landscape Summary Activity

Use the BWA TREX—Get Landscape Summary activity to retrieve a summary of the overall BWA landscape system health.

Step 1
On the Toolbox pane, click the BWA TREX—Get Landscape Summary activity and drag it onto the Workflow pane.

Step 2
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3
Click the Inputs tab.

Step 4
In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its operation on BWA.

Step 5
Complete the appropriate information in the following tabs:

- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6
Click the Save tool to save the activity definition.

BWA TREX—Get Last Reorganization Plan Activity

Use the BWA TREX—Get Last Reorganization Plan activity to retrieve the current state of index reorganization requirements and suggested plan.

Step 1
On the Toolbox pane, click the BWA TREX—Get Last Reorganization Plan activity and drag it onto the Workflow pane.

Step 2
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3
Click the Inputs tab.

Step 4
In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its operation on BWA.
Step 5 Complete the appropriate information in the following tabs:

- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save tool to save the activity definition.
BWA TREX—Get Load Metrics Activity

Use the BWA TREX—Get Load Metrics activity to retrieve current TREX system workload metrics.

**Step 1**
On the Toolbox pane, click the BWA TREX—Get Load Metrics activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the Inputs tab.

**Step 4**
Specify the following information:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>TREX host name to return metrics.</td>
</tr>
<tr>
<td>Minutes</td>
<td>Retrieve metrics within the past X minutes specified in this field.</td>
</tr>
<tr>
<td>Metric Names</td>
<td>Comma separated list of metric names to return.</td>
</tr>
<tr>
<td>Timeout (secs)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

**Step 5**
Complete the appropriate information in the following tabs:
- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the Save tool to save the activity definition.

BWA TREX—Get Loaded Indexes Activity

Use the BWA TREX—Get Loaded Indexes activity to retrieve the indexes that are currently online in the BWA instance.

**Step 1**
On the Toolbox pane, click the BWA TREX—Get Loaded Indexes activity and drag it onto the Workflow pane.
Step 2  
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3  
Click the **Inputs** tab.

Step 4  
In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its operation on BWA.

Step 5  
Complete the appropriate information in the following tabs:

- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6  
Click the **Save** tool to save the activity definition.
BWA TREX—Get Long Running Threads Activity

Use the BWA TREX—Get Long Running Threads activity to retrieve a list of currently active long running TREX engine threads.

**Step 1**
On the Toolbox pane, click the BWA TREX—Get Long Running Threads activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the Inputs tab.

**Step 4**
Specify the following information:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning Threshold</td>
<td>Enter the value for the amount of time before a thread reaches the Warning threshold (default is “5sec”).</td>
</tr>
<tr>
<td>Error Threshold</td>
<td>Enter the value for the amount of time before a thread reaches the Error threshold (default is “10sec”).</td>
</tr>
<tr>
<td>Timeout (secs)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

**Step 5**
Complete the appropriate information in the following tabs:

- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the Save tool to save the activity definition.

BWA TREX—Get Next Reorganization Plan Activity

Use the BWA TREX—Get Next Reorganization Plan activity to retrieve details of the next index reorganization plan.

**Step 1**
On the Toolbox pane, click the BWA TREX—Get Next Reorganization Plan activity and drag it onto the Workflow pane.
Step 2  On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3  Click the Inputs tab.

Step 4  In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its operation on BWA.

Step 5  Complete the appropriate information in the following tabs:
  - Target—Specify whether the defined process target should be used or overridden.
  - Credentials—Specify the runtime user whose credentials should be used for process execution.
  - Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
  - Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6  Click the Save tool to save the activity definition.
BWA TREX—Get Reorganization Summary Activity

Use the BWA TREX—Get Reorganization Summary activity to retrieve current state of index reorganization requirements and suggested plan.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>On the Toolbox pane, click the BWA TREX—Get Reorganization Summary activity and drag it onto the Workflow pane.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>On the General tab, enter the following information:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

| Step 3 | Click the Inputs tab. |
| Step 4 | In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its operation on BWA. |
| Step 5 | Complete the appropriate information in the following tabs: |
|        | • Target—Specify whether the defined process target should be used or overridden. |
|        | • Credentials—Specify the runtime user whose credentials should be used for process execution. |
|        | • Knowledge Base—Select the appropriate knowledge base article to associate with the activity. |
|        | • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow. |
| Step 6 | Click the Save tool to save the activity definition. |
BWA TREX—Get Service Statistics Activity

Use the BWA TREX—Get Service Statistics activity to retrieve current TREX engine service runtime statistics, such as CPU, memory and response time.

Step 1
On the Toolbox pane, click the BWA TREX—Get Service Statistics activity and drag it onto the Workflow pane.

Step 2
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3
Click the Inputs tab.

Step 4
In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its operation on BWA.

Step 5
Complete the appropriate information in the following tabs:

- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6
Click the Save tool to save the activity definition.
BWA TREX—Preload Index Activity

Use the BWA TREX—Preload Index activity to preload an index into the instance array memory.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Preload Index** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Inputs** tab.

**Step 4**
Specify the following information:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index ID</td>
<td>Index technical name for the index.</td>
</tr>
<tr>
<td>Timeout (secs)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

**Step 5**
Complete the appropriate information in the following tabs:
- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the **Save** tool to save the activity definition.

BWA TREX—Restart Service Activity

Use the BWA TREX—Restart Service activity to restart individual TREX service processes.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Restart Service** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>
Step 3  Click the **Inputs** tab.

Step 4  Specify the following information:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>TREX service to restart (Index Server, Name Server, etc.).</td>
</tr>
<tr>
<td>Host</td>
<td>Blade host name.</td>
</tr>
<tr>
<td>Port</td>
<td>TREX service port.</td>
</tr>
<tr>
<td>Timeout (secs)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

Step 5  Complete the appropriate information in the following tabs:
- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6  Click the **Save** tool to save the activity definition.
BWA TREX—Start Reorganization Activity

Use the BWA TREX—Start Reorganization activity to start the execution of the index reorganization.

**Step 1**  On the Toolbox pane, click the **BWA TREX—Start Reorganization Plan** activity and drag it onto the Workflow pane.

**Step 2**  On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**  Click the **Inputs** tab.

**Step 4**  In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its operation on BWA.

**Step 5**  Complete the appropriate information in the following tabs:

- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**  Click the **Save** tool to save the activity definition.

BWA TREX—Test HTTP Status Activity

Use the BWA TREX—Test HTTP Status activity to check the status of the TREX http server.

**Step 1**  On the Toolbox pane, click the **BWA TREX—Test HTTP Status** activity and drag it onto the Workflow pane.

**Step 2**  On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**  Click the **Inputs** tab.

**Step 4**  In the Timeout (secs) text field, enter the number of seconds to allow for the SSH call to complete its operation on BWA.

**Step 5**  Complete the appropriate information in the following tabs:

- **Target**—Specify whether the defined process target should be used or overridden.
Defining the BWA TREX Activities

- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the Save tool to save the activity definition.
BWA TREX—Unload Index Activity

Use the BWA TREX—Unload Index activity to unload an index from the BWA instance.

**Step 1**
On the Toolbox pane, click the **BWA TREX—Unload Index** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Inputs** tab.

**Step 4**
Specify the following information:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index ID</td>
<td>Index technical name for the index.</td>
</tr>
<tr>
<td>Timeout (secs)</td>
<td>Number of seconds to allow for the SSH call to complete its operation on BWA.</td>
</tr>
</tbody>
</table>

**Step 5**
Complete the appropriate information in the following tabs:
- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the **Save** tool to save the activity definition.
Defining the BWA TREX Activities
Understanding the Common Activities Content

The Intelligent Automation for SAP Pack for Common Activities contains content that is used in the other automation packs. This appendix contains the content included in the Common Activities automation pack. It contains the following sections:

- Automation Pack Content, page B-1
- Defining the Common Activities, page B-2

Automation Pack Content

Use the automation pack Properties dialog box to view the content (objects) included in the automation pack. For instructions on accessing the automation pack properties, see Accessing Automation Pack Properties, page 2-1.

The Common Activities automation pack provides additional activities that can be used in other automation packs. These are additional activities display in the Process Editor toolbox after the user has imported the automation packs.

The following table displays the activities that are provided by the Common Activities automation pack.

Note: To launch these activities, the runtime user should have local administrative rights to the target. If the runtime user does not have these rights, the activity will fail and display a message that the process has encountered a failed node.
Defining the Common Activities

This section provides instructions for defining the activities included in the Common Activities automation pack.

Defining the Convert Integer to IP Address Activity

Use the Convert Integer to IP Address activity to find change an integer to an IP address.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Integer to IP Address</td>
<td>Changes an integer to an IP address.</td>
</tr>
<tr>
<td></td>
<td>See Defining the Convert Integer to IP Address Activity, page B-2.</td>
</tr>
<tr>
<td>Convert IP Address to Integer</td>
<td>Changes an IP address to an integer.</td>
</tr>
<tr>
<td></td>
<td>See Defining the Convert IP Address to Integer Activity, page B-3.</td>
</tr>
<tr>
<td>Ping</td>
<td>Specifies the name or IP address of the server to be pingered.</td>
</tr>
<tr>
<td></td>
<td>See Defining the Ping Activity, page B-4.</td>
</tr>
<tr>
<td>Stop a Unix Process (via SSH)</td>
<td>Stops a running Unix process through SSH.</td>
</tr>
<tr>
<td></td>
<td>See Defining the Stop a Unix Process Activity, page B-5.</td>
</tr>
<tr>
<td>Stop a Windows Process</td>
<td>Stops a running Windows process.</td>
</tr>
<tr>
<td></td>
<td>See Defining the Stop a Windows Process Activity, page B-6.</td>
</tr>
</tbody>
</table>

Field Description

- **Name**: Name of the activity.
- **Type**: Display only. Displays the type of activity.
- **Description**: Text description of the activity.

**Step 1**
On the Toolbox pane, click the **Convert Integer to IP Address** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Inputs** tab.

**Step 4**
In the Integer Representation text field, specify the integer value to be returned as an IP address.
For example, entering:
- 0 returns an IP address of 0.0.0.0
- 3232271626 returns an IP address of 192.168.141.10
Defining the Common Activities

Step 5 Complete the appropriate information in the following tabs:
- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save tool to save the activity definition.

Defining the Convert IP Address to Integer Activity

Use the Convert IP Address to Integer activity to find change an IP address to an integer.

Step 1 On the Toolbox pane, click the Convert IP Address to Integer activity and drag it onto the Workflow pane.

Step 2 On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3 Click the Inputs tab.

Step 4 In the IP Address text field, specify the IP address to be returned as an integer.

Step 5 Complete the appropriate information in the following tabs:
- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save tool to save the activity definition.
Defining the Ping Activity

Use the Ping activity to ping a server during network troubleshooting.

**Step 1** On the Toolbox pane, click the **Ping** activity and drag it onto the Workflow pane.

**Step 2** On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3** Click the **Inputs** tab.

**Step 4** In the Destination text field, specify the host name or IP address of the server to be pingered.

**Step 5** Complete the appropriate information in the following tabs:

- **Target**—Specify whether the defined process target should be used or overridden.
- **Credentials**—Specify the runtime user whose credentials should be used for process execution.
- **Knowledge Base**—Select the appropriate knowledge base article to associate with the activity.
- **Result Handlers**—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6** Click the **Save** tool to save the activity definition.
Defining the Stop a Unix Process Activity

Use the Stop a Unix Process (via SSH) activity to stop a running Unix process.

Step 1
On the Toolbox pane, click the **Stop a Unix Process (via SSH)** activity and drag it onto the Workflow pane.

Step 2
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

Step 3
Click the **Inputs** tab.

Step 4
In the PID field, enter the ID for the process that you want to stop.

Step 5
Complete the appropriate information in the following tabs:
- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6
Click the **Save** tool to save the activity definition.
Defining the Stop a Windows Process Activity

Use the Stop a Windows Process activity to stop a running Windows process.

**Step 1**
On the Toolbox pane, click the **Stop a Windows** activity and drag it onto the Workflow pane.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the activity.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Displays the type of activity.</td>
</tr>
<tr>
<td>Description</td>
<td>Text description of the activity.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Inputs** tab.

**Step 4**
In the PID field, enter the ID for the process that you want to stop.

**Step 5**
Complete the appropriate information in the following tabs:

- Target—Specify whether the defined process target should be used or overridden.
- Credentials—Specify the runtime user whose credentials should be used for process execution.
- Knowledge Base—Select the appropriate knowledge base article to associate with the activity.
- Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

**Step 6**
Click the **Save** tool to save the activity definition.
INDEX

A

ABAP application server 3-4
ABAP system connection information 3-4
accessing
   Automation for SAP BW and BWA processes 4-2
   automation pack properties 2-1
   target properties 3-24
   task rules 3-10
activities, defining A-6
activity results, viewing 4-8, A-9
Advanced properties, Unix/Linux System 3-8
assignments and notifications 3-10
Assign Task Rule, creating 3-12, 3-18
Authentication properties, Unix/Linux System 3-8
automation pack
   content 2-3, A-1, B-1
   importing 1-4, 1-5, 1-6
   properties, accessing 2-1
Automation Pack Import Wizard
   launching 1-2
automation summary 4-9

B

BWA TREX - Cancel Running Reorganization activity A-10
BWA TREX - Cancel Running Reorganization properties A-10
BWA TREX - Continue Reorganization activity A-11
BWA TREX - Continue Reorganization properties A-11
BWA TREX - Delete All Indexes activity A-12
BWA TREX - Delete Index activity A-13
BWA TREX - Delete Index properties A-13
BWA TREX - Execute Query activity A-13
BWA TREX - Execute Query properties A-14
BWA TREX - Get Alert Details activity A-15
BWA TREX - Get Alert Details properties A-15
BWA TREX - Get Alerts activity A-15
BWA TREX - Get Alerts properties A-15
BWA TREX - Get Indexes activity A-17
BWA TREX - Get Indexes properties A-18
BWA TREX - Get Index Usage activity A-17
BWA TREX - Get Index Usage properties A-17
BWA TREX - Get Landscape Summary activity A-19
BWA TREX - Get Landscape Summary properties A-19
BWA TREX - Get Last Reorganization Plan activity A-19
BWA TREX - Get Last Reorganization Plan properties A-19
BWA TREX - Get Loaded Indexes activity A-21
BWA TREX - Get Loaded Indexes properties A-22
BWA TREX - Get Load Metrics activity A-21
BWA TREX - Get Load Metrics properties A-21
BWA TREX - Get Long Running Threads activity A-23
BWA TREX - Get Long Running Threads properties A-23
BWA TREX - Get Next Reorganization Plan activity A-23
BWA TREX - Get Next Reorganization Plan properties A-24, A-25
BWA TREX - Get Reorganization Summary activity A-25
BWA TREX - Get Service Statistics activity A-26
BWA TREX - Get Service Statistics properties A-26
BWA TREX - Preload Index activity A-27
BWA TREX - Preload Index properties A-27
BWA TREX - Restart Service activity A-27
BWA TREX - Start Reorganization activity A-29
BWA TREX - Start Reorganization properties A-29
BWA TREX - Test HTTP Status activity A-29
BWA TREX - Test HTTP Status properties A-29
configuring task rules 3-12
connection information
  SAP ABAP system, specifying 3-4
  Connection properties, Unix/Linux System 3-6
Continue A-11
Convert Integer to IP Address activity B-2
Convert Integer to IP Address properties B-2
Convert IP Address to Integer activity B-3
Convert IP Address to Integer properties B-3
copying task rules 3-22
creating
  Assign Task Rule 3-12, 3-18
  Notify Task Rule 3-19
  Update Task Rule 3-19
credentials
  SAP ABAP system, specifying 3-4
credentials, runtime user 3-2
deleting task rules 3-22
default
  runtime user, specifying 3-5
defining
  activities, general A-6
  BWA TREX - Cancel Running Reorganization activity A-10
  BWA TREX - Continue Reorganization activity A-11
  BWA TREX - Delete All Indexes activity A-12
  BWA TREX - Delete Index activity A-13
  BWA TREX - Execute Query activity A-13
  BWA TREX - Get Alert Details activity A-15
  BWA TREX - Get Alerts activity A-15
  BWA TREX - Get Indexes activity A-17
  BWA TREX - Get Index Usage Indexes activity A-17
  BWA TREX - Get Landscape Summary activity A-19
  BWA TREX - Get Last Reorganization Plan activity A-19
  BWA TREX - Get Loaded Indexes activity A-21
  BWA TREX - Get Load Metrics activity A-21
  BWA TREX - Get Long Running Threads activity A-23
  BWA TREX - Get Next Reorganization Plan activity A-23
  BWA TREX - Get Reorganization Summary activity A-25
  BWA TREX - Get Service Statistics activity A-26
  BWA TREX - Preload Index activity A-27
  BWA TREX - Restart Service activity A-27
  BWA TREX - Start Reorganization activity A-29
  BWA TREX - Test HTTP Status activity A-29
  BWA TREX - Unload Index activity A-31
  Convert Integer to IP Address activity B-2
  Convert IP Address to Integer activity B-3
  Ping activity B-4
  Stop a Unix Process activity B-5
  Stop a Windows Process activity B-6
dependencies
  Automation for SAP BW and BWA, viewing 2-10
  Core Automation for SAP BW, BOBJ and In-Memory Computing A-4
disabling task rule 3-20
default
  runtime user, specifying 3-5
defining
  activities, general A-6
  BWA TREX - Cancel Running Reorganization activity A-10
  BWA TREX - Continue Reorganization activity A-11
  BWA TREX - Delete All Indexes activity A-12
  BWA TREX - Delete Index activity A-13
  BWA TREX - Execute Query activity A-13
  BWA TREX - Get Alert Details activity A-15
  BWA TREX - Get Alerts activity A-15
  BWA TREX - Get Indexes activity A-17
  BWA TREX - Get Index Usage Indexes activity A-17
importing
  automation pack  1-1, 1-4, 1-5, 1-6
incidents  4-8

K
knowledge base articles  2-8

M
managing
  target properties  3-24
  task rules  3-20
monitoring
  SAP ABAP application server  3-4
  server availability  3-5

N
New SAP System Wizard  3-3
Notify Task Rule, creating  3-19

O
objects
  Automation for SAP BW and BWA, viewing  2-3, 2-10
override process target  4-6

P
Ping activity  B-4
Ping properties  B-4
processes
  accessing  4-2
  activity results, viewing  4-8
  Automation for SAP BW and BWA  2-3
Core Automation for SAP BW, BOBJ and In-Memory Computing  A-4
  notification based on assignment  3-23
  override target  4-6
  starting process  4-6
  viewing execution  4-7
  viewing results  4-8
properties
  BWA TREX - Cancel Running Reorganization  A-10
  BWA TREX - Continue Reorganization  A-11
  BWA TREX - Delete Index  A-13
  BWA TREX - Execute Query  A-14
  BWA TREX - Get Alert Details  A-15
  BWA TREX - Get Alerts  A-15
  BWA TREX - Get Indexes  A-18
  BWA TREX - Get Index Usage  A-17
  BWA TREX - Get Landscape Summary  A-19
  BWA TREX - Get Last Reorganization Plan  A-19
  BWA TREX - Get Loaded Indexes  A-22
  BWA TREX - Get Load Metrics  A-21
  BWA TREX - Get Long Running Threads  A-23
  BWA TREX - Get Next Reorganization Plan  A-24, A-25
  BWA TREX - Get Service Statistics  A-26
  BWA TREX - Preload Index  A-27
  BWA TREX - Start Reorganization  A-29
  BWA TREX - Test HTTP Status  A-29
  BWA TREX - Unload Index  A-31
  Convert Integer to IP Address  B-2
  Convert IP Address to Integer  B-3
  Ping activity  B-4
  Restart Service  A-28
  Stop a Unix Process  B-5
  Stop a Windows Process  B-6

R
Restart Service properties  A-28
runtime user
credentials, specifying 3-2

S
server availability
   specifying servers 3-5
sorting task rules 3-22
specifying
   availability monitoring 3-5
   default runtime user 3-5
   runtime user credentials 3-2
starting processes 4-6
Stop a Unix Process activity B-5
Stop a Unix Process properties B-5
Stop a Windows Process activity B-6
Stop a Windows Process properties B-6

T
target properties
   accessing 3-24
   managing 3-24
   task rules 3-10
      accessing 3-10
      assign 3-12
      conditions 3-15
      configuring 3-12
      copying 3-22
      deleting 3-22
      disabling 3-20
      enabling 3-20
      General properties 3-14
         managing 3-20
         sorting 3-22
         task types 3-14

U
Unix/Linux System
   Advanced properties 3-8
   Authentication properties 3-8
   Connection properties 3-6
   Update Task Rule, creating 3-19

V
viewing
   activity results A-9
   Automation for SAP BW and BWA dependencies 2-10
   Automation for SAP BW and BWA global variables 2-7
   Automation for SAP BW and BWA objects 2-3, 2-10
   Automation for SAP BW and BWA processes 2-3
   automation pack content 2-3, A-1, B-1
   automation pack dependencies A-4
   automation summary 4-9
   Core Automation for SAP BW, BOBJ and In-Memory Computing processes A-4
   incidents 4-8
   process activity results 4-8
   process results 4-8
   running process 4-7